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1 Software Installation

1.1 Software Installation

Running Environment

To ensure the optimal performance of Kompass FX3 Pro, the following minimum system
requirements must be met:

Processor: Intel i7 9th generation or above
Memory: 16 GB or above DDR4 2666

Graphics card: Recommend NVIDIA P2200 or higher - level discrete graphics card, or AMD
W5100 or higher -level discrete graphics card

Storage: 512 GB or larger SSD

Operating system: Windows 10 Ent erprise LTSC

Installation Procedure

E Note

The following installation pictures are for illustration purposes only. The actual pictures may

vary.

Step 1 Double click Kompass FX3 Pro installer, and the program will automatically enter the installation

interface.
Step 2 Check I've read and agreed to the NovaStar Software License Agreement

Click the installation path below to modify the software installation location.
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Figure 1-1 Software installation

V74

Multimedia Playback Software

Step 3 Click Install Now to enter the software installation interface.

Figure 1-2 Automatic software installation

Multimedia Playback Software

Installing... Please wait.

Step 4 Once the software installation is complete, click Try Now to exit the installation interface and

automatically launch the software.

www.novastar.tech 6
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Figure 1-3 Installation completed

I 4

Multimedia Playback Software

¥

E Note

It is recommended to disable the antivirus software and firewall in advance.

During the installation process, if antivirus software or a firewall prompts to block the
installation, please choose to allow it.

After the software installation is complete and a restart is prompted, it is recommended to

restart the system promptly.

1.2 Software Licensing

Kompass FX3 Pro supports two authorization modes: Temporary and permanent.
Temporarily authorized: The remaining days of authorization is displayed at the top right.
Permanently authorized: No authorization message is displayed at the top right.

Not authorized: Trial is displayed at the top right.

If you want to obtain authorization, please contact our sales engineer for purchasing the dongle

or registration code.
In trial mode, the Kompass FX3 Pro text is displayed on the output.
Dongle detection rules are as follows:

When the inserted dongle is recognized, Trial will disappear automatically and the output

will not display the Kompass FX3 Pro text.

Within 3 seconds after the dongle is removed, the software knows the  dongle has been
removed and prompts you that no dongles have been detected, and the software will again

display the Kompass FX3 Pro text on the output in 5 seconds.

www.novastar.tech 7
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. When the dongle is inserted and recognized normally, the above window and the  Kompass

FX3 Pro text on the output will disappear automatically.

Figure 1-4 Dongle detection

A No license found

Thi vare requires Kompass FX3 Pro dongle,

@ License Information

Register

Please scan the QR code and send the copied content to your sales representative to obtain the
registration code. Once obtained, enter the registration code into the text box below the QR

code and click Register to complete the software authorization.

www.novastar.tech 8
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2 Applications

Figure 2-1 Application scenarios

Contraller Controller Controller

Kompass FX3 Pro

St
N

Media Files

/

Monitor
Laser Pointer

keyboard Mouse
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3 User Interface Introduction

3.1 User Interface

Run the software, and the main user interface is as shown below.

Figure 3-1 User interf ace

3.2 Menu Bar

Figure 3-2 Menu bar

#=F File PResource Output Window Link Settings Tools Help £A\i+

OCE®m R KB B & & @S

File: Perform the project - related operations.

T New: Create a new project.

1 Open: Open the saved project file.

1 Save: Save the current project file.

T Save As: Save the currently edited project file as a new project file.

T Package Project: Package and store the used media files currently being edited or all

media files in the project package.

www.novastar.tech 10
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[ Exit: Exit the software with the option to save the current project before exiting.
Resource: Add and delete local media.

1 Add Local Me dia: Add the local media files.

[ Add Local folder: Add a local media folder and all supported media within the folder.

T New Folder: Add an empty folder to the library.

[ Clear Library: Delete all imported local media files.

Output: Manage the output screens, | ink configurations, and edge blending settings. Click
m)

the shortcut icon 00 below to open the output management window.

Window: Show or hide the specific user interface areas, including the media library, input
sources, editing area, global control, timecode , properties, program management, playback
progress, timeline, and output control.

Link: Configure the master - slave or primary - backup connections.
Settings: Configure the system settings, including general system settings and shortcuts.

Tools: Use Playback Control Assistant for media transcoding, employ Play Log to view and

export playback logs, and utilize Port Check to check system port information.

Help: Check the software help documentation and software information, as well as switch
preferred language.

: Open Al Assistant to perform Al chat and text -to-image operations.
I
: Create a new project.
|B: Save the currently edited project.
E: Package the current project.
El: Restore the user interface layout to the default layout style.
E|/: Save the adjusted lay out as a new layout.
FO: Load or delete a saved layout.
o
¢ Shortcuts are hidden. Click to show the shortcut keys.
_—
@: Shortcuts are shown. Click to hide the shortcut keys.

00 : Click to enter the output management interface.

www.novastar.tech 11
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<>
Q : Click to enter the 3D editing interface.

<P . : L .
: Click to access the page turning control and view its instructions; when enabled, the

icon changes to

: Click to enter the scheduled playback interface; when activated, the icon changes to

3.2.1 Modify Layout

The main interface can be adjusted according to user preferences.

Step 1 Click 53 at the top - left corner of the layout you wish to modify to unlock the layout.

Step 2 Place the mouse cursor on the edge of any area. When the cursor changes to a double -headed

arrow, hold down the left mouse button and drag to resize the area.

Step 3 Position the mouse cursor on the title bar of any area. Hold down the left mouse button and

drag to reposition the area.

S
Step 4 Click >\ at the top - left corner of the layout to lock it. Once locked, the icon will change to

g

E Note

Click E at the top left corner of the user interface to restore the adjusted layout to the

default one.

After completing the layout modification, click E" and enter the new layout name in the

pop - up dialog box to save the current layout.

3.2.2 Load Layout

You can quickly load and apply a layout style via this function, without needing to adjust each

area individually.

Step 1 Click FO at the menu bar to open the layout management window.

www.novastar.tech 12
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Figure 3-3 Load layout

Layout Management

Layout 1

Cancel Delete Load

Step 2 In the layout list, select the target layout.
Step 3 Click Load.

Here, the following actions can also be performed.
Delete: Remove the selected layout template from the layout list.

Cancel: Cancel layout loading and exit the layout loading interface.

3.2.3 Lock User Interface

Locking the user interface prevents unauthorized access to the editing environment, particularly
when the operator is away.
Step 1 Click & at the top right of the main interface to open the Ul locking window.
Figure 3-4 Lock user interface
Lock User Interface

Password

Opacity

Auto Lock Never

[ Lock user interface on startup

Cancel OK Lock Now

Step 2 Enter the password in the text box nextto Password .

Clicking ~ or © next to Password allows you to show or hide the password.

Step 3 Adjust the opacity of the lock screen.

www.novastar.tech 13
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An opacity setting of 100% means it is completely opaque, obscuring the editing interface and

showing only the lock screen background.
Step 4 Define the duration of inactivity a fter which the system will automatically lock itself.

Options include Never, 3 minutes , 5 minutes , 10 minutes , and 30 minutes , with Never

indicating no automatic screen locking.
Step 5 Decide whether to lock the user interface upon software launch.

Select Lock user interface on startup  to default to the lock screen when the software starts
up.
Deselect it to display the main software interface after startup.

Step 6 Confirm the settings by clicking OK.

By clicking Lock, the system enters to the lock screen mode, and the screen lock settings take
effect.

E Note

To unlock, enter the previously set password and click to access the software editing
interface.

If the password is forgotten, please contact our technical support engineer for assistance.

3.2.4 View System Messages

The system will provide alarms or messages in Message Center .

Upon opening the project, the system will verify the status of the EDID lock and sync card,

issuing an immediate warning in the message center if any issues arise.

T If the EDID is not locked, click Lock on the right of the message, and the system will lock
the device EDID using the EDID shortcut tool.

T If not synchronized, clicking Sync on the right of the sync message will direct the system

to the graphics card control panel for synchronization settings

While the software is in operation, the system will continuously monitor the usage of CPU,
GPU, and memory. If usage reaches or exceeds 85% for 30 consecutive seconds, an alert will

be issued.

In the event of an abnormal graphics card usage alert, clicking View on the right of the alert

will navigate to the Task Manager to examine and address the abnormal processes.

www.novastar.tech 14
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Click Q at the top right corner to open the Message Center interface.

Figure 3-5 Message center

@ Warning

Clear: Clear all messages.
Read All: Set all messages as read.

Do Not Disturb: Toggle message natifications on or off. When enabled, the system will not

display message alerts, but will log them in the message center.

X X

: Click the icon next to each message to delete it. Click next to Message Center to
close the message center window.

3.3 Global Control

Control the output display, volume and more.

Table 3-1 Global control descriptions

Area Function Description

Output control ] )
: Output connected. Click to disconnect the output.

x]

: Output disconnected. Click to restore the output

connection.

www.novastar.tech 15
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Area Function

Description

Test pattern

: Test pattern enabled. Click to close the test pattern.

]

: Test pattern disabled. Click to open the test pattern. Once
the test patt ern is enabled, the screen will display the test

pattern.

FTB

FTB

: Normal output. Click to make the screen gradually fade to
black.

: FTB enabled. Click to gradually transition the black screen
to normal display.

. 0.5 s: The time duration from normal displ ay to a black screen.
This can be manually input with a range from 0 to 5, with a
default value of 0.5 seconds.

Adjust the output brightness gain by moving the slider. The value
ranges from -100 to 100.

Adjust the output volume. Click to mute all outputs.

3.4 Stage Editing Area

Preview the output screen or output slices.

Figure 3-6 Stage editing area

Editing Area (Live)

T
Outputlel

The sequence number in the upper left corner of the slice indicates the layer slice in program

management. This number corresponds one -to-one with the layer number, which can be

modified in the Bind Input section of the properties.

The Tx number in the upper left corner of the slice, where x is a digit, represents the timeline

layer slice. Slices on the timeline do not support layer binding modifications

www.novastar.tech
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Control Mode

Fl
Click - in the top right corner of the editing area to select the control mode, which

supports both Live and Pre- Edit.

[ Keep progress

Mode Name Description
— Live After this mode is selected, the stage area displays the live
image of the current program.
B
i
Pre- Edit After this mode is selected, the stage area displays a preview

of the program to be played. Only after clicking Take can the
playing program be output to the screen.

. Cut: Send the currently previewed program to the screen

using the direct cut m ode.

. Take: Send the currently previewed program to the screen
using a fade - in, fade - out mode.

. Keep progress: When sending programs, determine
whether the program should play from the beginning of the

media.

1 On: The program starts playing from the current
progress in the preview area after you click Take or
Cut.

i Off: The program starts playing from the beginning

after you click Take or Cut.

Editing Area Control

&’/ &: Unlock or lock the stage editing area. Once locked, any additions, modifications,

or movements of slices are not allowed.

|-EI: Capture the current playback frame of the selected slice and automatically add the

captured image to the media library.

ra

K J: Fill the selected layer across the connectors.

a0
o

-: When the screen is moved, click to automatically move the screen back to the origin.

www.novastar.tech
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. / B: Zoom in or zoom out the editing area.
©

interface.

: Show or hide all text displays in the stage editing area or screen management

When hidden, only images are shown without any text on slices or sub -outputs. Click

to show text again.
(D: Reverts the last action(s) and restores the previous state.

C>: Reapplies the most recently undone action.

After hiding text, press and hold the ALT key to temporarily display text, 0  r release the ALT

key to continue showing text.

3.5 Program Management

Manage the programs and layers.

Figure 3-7 Program management

Program  Timeline

+ P (5/50) > P1

Layer1

© D &

Layer2

®> D G |4

;. #gr:
Layer3 . ;

© D G |14 05
| SPeiA

Program n/50: Displays the number of edited programs and the total number of programs in

the current group.
T n: Indicates the number of programs that contain media.

T 50: The default number of programs in the system, which will increase as more

programs are added.
Program: The program name

Layer control: Manage the display image and output audio of the layers.
T @: The layer image is displayed normally. Click to hide the layer image.

T ”T(: The layer does not display any image. Click to show the layer image.

T 'ﬂ)) The layer audio is output normally. Click to disable the layer audio.
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NOVASTAR Kompass FX3 Pro Multimedia Playback Software

Advanced Edition User Manual

T qx: The layer audio is disabled. Click to enable the layer a udio.

1 £|: The layer is not locked, allowing for adding media and other operations. Click to
lock the layer.

T &l: The layer is locked. Once the layer is locked, you cannot add programs, delete

media, or perform other operations on this layer. Click to unlock the layer.
i + : Click +

layers are supported.

at the leftmost of the layer management area to add a layer. At most 40

Program media jump playback: When the media is set to jump playback, different status

icons will be displayed in the upper right corner of th e media in the program.

“
T = : The media plays in a loop, and it loops before transitioning to the next media.

- A

[ : Before the media jumps, and after the media finishes playing, freeze on the last

frame.

[ : Before the media transitions, and after the media finis hes playing, it stops.

T > - After the current media loop, all media within the program will play on loop.

T P . After the media finishes playing, switch to the next program for playback.
T EH . After the media finishes playing, it will switch to the designated prog  ram.
A

T S : The media loops continuously and plays a specified number of times before it

moves on.

Program control: Includes the program positioning, program addition, and program playback

control.

N

[ : Click this icon on the left of the program name to start pl aying or resume the

current program.

T I I : Click this icon on the left of the program name to stop playing the current
program.

(=]
(=]
1 = Click this icon to enable the layout retaining feature. When enabled, the icon

changes to = and all slice information remains co nsistent across programs.

1 EEIl : Click this icon to clear media from all programs.
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0
R

<: When the program moves left or right, click this icon and the program list will
automatically position at the first program on the left side.

[ @ : Click to place the currently playing program as the first program on the left side of
the program list.

.+

[ : Add a program to the end of the program list.

3.6 Timeline

Manage the timeline and the layers on it.

Figure 3-8 Timeline management

Program  Timeline

Add layers

In the Library on the right, select a media and drag it to the blank area of the timeline to

create a layer and complete the media addition to the layer.
Replace media

Replace the selected media on the timeline. In the media library, select the target media and
drag it onto the media in the timeline to open the media replacement popup, allowing the
following actions:

T Keep: Retain the original media's properties, including start time and duration, when
replacing.

T Don't Keep: Replace the selected media on the timeline with out retaining the original
properties.

T Cancel: Do not replace the media on the timeline.
Delete layers

After all media on the timeline layer is deleted, the timeline layer will be automatically
deleted.

Lock timeline
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T Click &’ above all layers in the timeline area to lock all layers. Once locked, adding

layers and media is not allowed.

T Click & next to each timeline to lock it. Once locked, adding and removing media

from the current timeline is not allowed.

Control timeline play back
T @: Stop the timeline playback.
T ®: Start the timeline playback.
T 69 When the playback position is within a clip, play it once, then pause at the end.
(D: When the playback position is within a clip, loop the playback.
T @: Click to jump to and play the pre vious clip.
®: Click to jump to and play the next clip.
®: Click to jump to the beginning of the timeline and restart the playback.
T q)) Turn on or turn off the layer media audio.
T &l: Click this icon next to the layer to lock the layer.
T ©: Hide the media imag e of the layer.

] @: Click to zoom in the timeline.

] aCIick to zoom out the timeline.

T Layer stacking order determines display priority. The topmost layers have the highest

priority and appear foremost.

3.7 Playback Control

Control the playback of a single media o r all media of the currently playing program.

Figure 3-9 Playback control

www.novastar.tech 21



NOVASTAR Kompass FX3 Pro Multimedia Playback Software

Advanced Edition User Manual

Overall control: Manage the playback of all media in the current program.
T I’: After the icon is clicked, all media start playing.

T “: After the icon is clicked, all media pause.

T I:I: After the icon is clicked, all media stop playing.

Single media control: Control the playback for the selected media in the current program.

N

[ : Click this icon in front of the playing media to continue playing the media.

T I I : Click this icon in front of the playing media to pause playback of the media.

Playback timers: Counting up, counting down, and synchronized playback control for media
T ® : Start the count up display, showing the duration of all media that has been played.

T : Start the countdown display, sh owing the remaining playback time for all media.

—
T S~ : Start the synchronized playback control. Click and drag the media playback

progress bar to synchronize the playback time.

3.8 Media Library and Properties

Figure 3-10 Media library and properties

Library  Properties Input Sources  Output Control  Effects Library
w4
Name Status Al ¥  Format R ion Duration
Norma
Normal Video mov
Golf Normal Videc mp4
Grape Normal Video mov
Panda Normal mov
Normal

abc Normal Office pptx

Testimag.. Normal Image png 1920%1080

Media Library

Add and manage the added media.

Tar

Delete media: After selecting the media that has not been added to any programs, click

in the top right corner to delete the selected media.
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When selecting media, press and hold Ctrl or Shift to select multiple med ia.

Manage media: Add and manage media in the media library.

T Click +

in the top right corner to enter the local media addition interface.

[ Right click a blank area in the media library to perform actions such as  Add Local
Media, Add Local Folder , New Folder , Add Collection , and Clear Library .

[ By dragging the added media into the newly created folder, you can categorize and
manage the media.

[ By clicking All at the top and choosing different types, you can view the added media
by categories.

Single media operations: Right click a media in the media library to expand the media

context menu.
Figure 3-11 Media context menu

Add Local Media
Media Optimization
Add Collection

Add Local Folder
Insert Folder

Maore Tools

Rename

Replace Media

A File Location
EE

Properties

T Add Local Media: Add the media files saved locally.

[ Media Optimization: When the size of added media files exceeds the processing
capability of the graphics card, the media type will display = Optimizable . For the specific
processing capability each graphics card supports, please refer to the table below. Onc e

optimized, the media will display Optimized .

Graphics Card Image Video

P2200 Width or height > 16384 Width or height > 8192 pixels, or
pixels i EZKNBKTF

T400 Width or height > 8192 Width or height > 8192 pixels, or
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Graphics Card Image Video
pixels bandwidth > 81 A
RTX 4000 Width or height > 16384 Width or height > 8192 pixels, or
RTX5000 pixels i EZKNBKTEF
RTX A4000
RTX A5000
RTX A5500
RTX A6000
Other graphics cards Width or height > 8192 Width or height > 8192 pixels, or
pixels i EZKNBKTTY

E Note

Media in hap format will not display Optimizable even if they exceed the maximum

recommended resolution.

Properties

Cancel Optimization: Reverts optimized media back to its pre -optimized state.

Add Collection: Arrange and combine multip le videos or images to create a new video

playlist, where the videos and images will automatically loop based on the set mode.
Add Local Folder: Add the local folders and media within the folders.

Insert Folder: Insert a new folder and add the selected med ia to the inserted folder.
More Tools: Add the OSDs and custom test patterns.

Rename: Modify the name of the selected media.

Replace Media: Replace the media in the material library and meanwhile replace this

media in all programs together.
Access File Location: Open the local storage location of the media file.

Delete: Delete the selected media. If the media has already been added to the program,

it cannot be deleted.

Properties: View the basic properties of the selected media.

Click the media in the program to view and modify the properties of the individual media in

the program.

Click the slice in the editing area to view and modify the output slice properties.
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Click the layer to view and modify the layer properties, and change the output of all media in

the layer by adjusting the layer property values.

Click the program to view and modify the program properties.

Input Sources

Add and manage the capture device sources, streaming media, NDI input sources and webpage

sources.

Output Control

Manage the backend device by adding control commands.

E Note

It is recommended that only personnel with professional training perform this operation.

Effects Library

Kompass FX3 Pro offers a collection of preset or custom visual effects, letting users swiftly

apply them during program setup to boost visual impact.

Simply drag an effect onto a slice or into the program media to add it.

3.9 Exit Software

Click X in the upper right corner of the software interface, or choose  File > Exit. A

confirmation dialog will appear .

Figure 3-12 Exit confirmation

Cancel Don't save
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Close Display Terminal

Check Close display terminal to ensure the output interface closes with the main interface.

Leave it unchecked to keep the output display running according to the program

management even after the ma in interface is closed.

Save Project File

Save: Save the current project file when the software closes.
Don't save: Close without saving the current project file.

Cancel: Cancel the software close.
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4 Project

4.1 Create New Projects

There are three methods for creating a new project:

After launching the software, click New Project on the startup screen, select the storage
location for the new project, and then click Save. The system will automatically create a
project file.

Navigate to File > New, choose the new project's storage location, and click OK to create a

new project file.

I
Click in the menu bar to create a new project file.

4.2 Manage Media

Kompass FX3 Pro supports processing and playing images, videos, PowerPoint files, and audio
files.

The supported medi a formats are as follows:
Video: mp4, avi, mkv, flv, mov, mpeg, mpg, ts, wmv, 3gp
Image: jpg, jpeg, bmp, png, gif, ico
Audio: mp3, aac, flac, amr, ape, wav, wma, ogg
Office: ppt, pptx

ppt and pptx decoding supports up to a 4K resolution size.

E Note

Recommended video encoding formats:
q OLPByOTSHZP q NBkTF EZk FLSG6FT N
CLPBYyOTSEHZP q A ¢ < OL1 BZZLZKLKk

F'dat)

For a better image quality experience, the following video bitrates are recommended.

Recommended vide o bitrates for SDR uploads - single media server and single graphics
card:
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Type Video Bitrate Standard Frame Rate (24 Video Bitrate High Frame Rate
Hz, 25 Hz, 30 Hz) (48 Hz, 50 Hz, 60 Hz)

4320 (8K) 75 to 90 Mbps 110 to 135 Mbps

2160p (4K) 35 to 45 Mbps 53 to 68 Mbps

1440p (2K) 16 Mbps 24 Mbps

1080p 8 Mbps 12 Mbps

Recommended video bitrates for SDR uploads

- multiple media servers and multiple graphics

cards:
Type Frame Rate Video Bitrate Video Coding
4320 (8K) 60 Hz 30 Mbps H.265
2160 (4K) 60 Hz 30 Mbps H.264

E Note

If frame synchronization output is not required in the application scenario that has multiple

media servers and multiple graphics cards, please refer to the recommended video bitrates for

SDR uploads - single media server and single graphics card.

Video Media Requirements

The video playback performance varies depending on the graphics card. To ensure optimal

compatibility and smooth playback, please prepare and add media materials according to the

following specifications:

Requirements for si ngle graphics card scenario:

F

L

L

i qg liskLb ¢LPBYyOTSDHZ NST Ly®P NB k TF
i qg liskLb ¢LPBYyOTSDHZ NST Ly®P NB k TF
i AOUNLO qg lj8kLDb ¢LPBYyOTSEDHZ NSTLyYyP EZk
HAP
Requirements for multi - graphics card scenario:
i q lj8kLb ¢LPBYyoOTSDHZ NST Ly®P NB k TF
i q lj8kLb ¢LPBYyoOTSDHZ NST Ly®P NB k TF
T Super 8K video: Requires segmentation, with all segments of equal duratio n.
28
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E Note

Video playback must utilize hardware decoding, with a frame rate of 30/60 fps, and a

recommended video bitrate under 200 Mbps to ensure synchronization.

Graphics Card | Resolution Frame Rate Encoding Pixel Format Bitrate Range
Format
AMD 60 H.264 YUV4:2:0/'YUV4:2:2 | 0 to 300 Mbps
60 H.264 (HDR) | YUV4:2:0/YUV4:2:2 | 0to 300 Mbps
MPGT400 60 H.265 (HDR) | YUV4:2:0/YUV4:2:2 | 0to 300 Mbps
HPGA4000 60 H.265 (HDR) | YUV420/YUV422 0 to 450 Mbs
60 Prores422 YUV420/YUV422 No
HQ requirements
60 Prores422 YUV420/YUV422 No
HQ requirements
HPGAS5000 60 H.265 (HDR) | YUV420/YUV422 0 to 150 Mbs
60 Prores422 YUV420/YUV422 No
HQ requirements
HPGA6000 60 H.265 (HDR) | YUV420/YUV422 0- 150Mbs
60 H.265 (HDR) | YUV420/YUV422 No
requirements
HPGA4000 60 HAP YUV420/YUV422 No
HGPA5000 requirements
HPGAG000

4.2.1 Add Media

Import a single media file or multiple media files.

4.2.1.1 Import Files

Step 1 On the right pane, click the Library tab to enter the media library interface.

Step 2 Right click the blank area and select Add Local Media .
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Step 3 Select the target media and click Open. The software will automatically import the selected
media files into the media list.

To import a single file, simply select the file and click Open to complete the import.

To import multiple files simultaneously, press and hold Shift or Ctrl click the target files, and
then click Open to complete the import.

4.2.1.2 Import Folders

There are two me thods for importing folders.
Import Folders

Step 1 Right click the blank area in the media library area, and select Add Local Folder .

Step 2 Select the folder where you save the media files and click Open.
The system will automatically import the folder with its origina | name and the media files within
the folder into the media library.

Replace Folders

Step 1 Right click the blank area in the media library area, and select Insert Folder . The system will
automatically create a new folder.

Step 2 Right click the folder and select Replace.
Step 3 Select the folder you want to import in the pop - up dialog box.

Step 4 Click Open to import the selected folder and its contents into the media library simultaneously.
4.2.1.3 Add Media Collections

This function allows you to sort and combine multiple videos or images  to form a new kind of
video source. Videos and images within the collection will automatically play in turn based on
the set mode.

Step 1 Inthe Library area, right click and select Add Collection .
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Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Figure 4-1 Add media collections

Add Collection

Name Collection 1

All Media

Enter the name of the media co llection in the Name section.

In the Playback section, select the media playback order within the media collection. The

options include Sequential and Shuffle .

Sequential: The collection media is played sequentially according to the arrangement in the

collection.

Shuffle: The collection of media plays in a random order.
In the Transition section, set the transition effect for the media in the collection.
Currently, only Cut is supported.
Select the media for which you need to create a collection from  All Media.

If the media have been organized into folders, the folder name will be displayed here. Double

click the folder to expand it and show the media within.

Click »

in the middle to add the selected media to the Collection Media on the right.
In the Collection Media area, select the desired media.
Set the playback duration.

Double click the playback duration section of the media to set the playback duration of the

media in the collection.

If the set playback duration is longer than the media duration,  the media will automatically

loop until the playback duration is complete.
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If the set playback duration is shorter than the media duration, the media will automatically

stop playing once it reaches the playback duration.
Step 9 Set the number of media playbacks.

Double click the count section of the media to adjust the playback times of the media in the

collection.

Step 10 Click Save to complete the media collection setup.

Other Operations

Delete media

In the Collection Media area, select the media you want to delete, an d then click the Delete

button or press the Delete key on the keyboard to remove the selected media.
Sync duration

Select the media with a set playback duration, click Sync and you can set the playback of

other media to match the selected media's duration.

4.2.1.4 Add OSDs

Kompass FX3 Pro supports the OSD as a kind of media.

Step 1 Inthe Library area, right click the blank area and select More Tools > Add OSD.
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Figure 4-2 Add OSDs

Preview Width 289 px Height 56 px

Enter text here

Text:

Enter text here

B I d T =
Name OS! Font ARIALN Font Size 48
Color Solid Color

CharS... 2

Direction Horizontal

Layout @® Adaptive O WordWrap O Collapsed O Custom

Scrolling

Cancel | OK

Step 2 Enter the desired content inthe Text area.
Step 3 Adjust the font and style.

You can set the fol lowing attributes.
B : Make the text bold or not.
: ltalicize the text or not.

I
u

: Underline the text or not.

. Align the text to the left.

When the display area width is larger than the text width and the moving is set to Static ,

align the text to the left of the display area.

: Center the text horizontally.

When the display area width is larger than the text width and the moving is set to Static ,

center the text horizontally to the display area.

: Align the text to the right.
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When the display area width is larger than the text width and the moving is set to Static ,

align the text to the right of the display area.

T : Align the text to the top.

4

T : Center the text vertically.

+

: Align the text to the bottom.
Step 4 Enter a name next to Name.
Step 5 Set the font and font size.

Select the desired font from the drop -down list and the default fontis Arial .

Select the desired font size from the drop -down list and the default size is 48. You can only

select a number from the drop -down list and you ca nnot enter a number manually.
Step 6 Set the font color.

Gradient and Solid Color are supported.
Solid Color: Select Solid Color from the drop -down list and select the desired color block

next to Presets.

When you are not interested in any of the preset colors, ¢ lick == to open the Select Color

window to customize your own color, and then click OK to complete the pure color settings.

After selecting the input text, you can individually set the color of the selected text, but it can

only be set to a solid color.

Color Solid Color ~ A Presets |l HEB

Gradient: Select Gradient from the drop -down list and the default gradient color is

displayed.

Click two color blocks at the both ends of the gradient color to customize your own gradient

colors. Set the gradient angle to complete the gradient color setting  s.

Color Gradient Gradie... Angle 0

Step 7 Set the character spacing, line spacing, and text direction.

Char Space: Set the horizontal distance between adjacent characters. A larger value results

in looser spacing, and a smaller value makes it tighter, ranging from 0 to 30 pixels.

Line Space: Set the vertical distance between consecutive lines of text. A larger value results

in looser spacing, and a smaller value makes it tighter.
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Step 8 Direction: Set the orientation of the OSD text. The options include Horizontal and Vertical .

Step 9 Set the typography inf ormation for text captions. The options include Adaptive , Word Wrap ,

Collapsed, or Custom .

Adaptive: The text displays responsively.

Selecting this option ensures the text display area adjusts automatically according to the text

size, facilitating a complete and coherent presentation.

Word Wrap: Continuous text naturally wraps according to display width, maintaining content

coherence.

The display width must be set here. Once configured, the text display area wraps according

to this width, ensuring the text is presented fully and aligns with expected layout.

Collapsed: Segments text strictly according to specified collapse width, possibly truncating

text and leaving space, suitable for structured layout needs.

The text will be forcibly trimmed according to the subsequent Display Width setting, even if

it may truncate text and leave blank spaces, satisfying specific formatting requirements.
T When Collapse Width  Display Width , the text displays normally.

1 When Collapse Width > Display Width , the text is tr immed to the set display width,

retaining only the text within that width.
i When Collapse Width § P yLPP TFEZ TLIT NBKTF TFL TLI T NI
Custom: Text is trimmed according to predefined Display Width and Display Height .

T When Display Width < text width, the text is trimmed to the set display width, retaining
text within that width.

i When Display Width TLT T NBKTEF TFEL TLIT k8§PNYETP ZbBbOZI

T When Display Height < text height, the text is trimmed to the set display height,
retaining text within that height.

i When Display Height TLTT FLSGFT TFL TLIT k8§PNYET P ZbHO

E Note

For Collapsed and Custom settings, trimming the text is related to the text alignment.

Step 10 Set the moving effect and speed.

Scrolling: The options include Static , Left to Right , Right to Left , Top to Bottom and
Bottom to Top .
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Speed: Set the moving speed. This parameter is available when the moving effect is not
Static .

Infinite Scroll: Set whether the scrolling text should seamlessly connect.

[ Checked: The scrolling text will seamlessly connect the end of one sequence with the
beginning of the next. If selected, you must also set Space, which defines the spacing

between the end of one scroll and the start of the next.
[ Unchecked: The text will complete one scroll before starting the next.
Step 11 Click OK to complete the OSD settings.
Once the OSD is added, it appearsas Tools $§ Z TFL ZLKSE ysi OEOT
Right click the added OSD and select Edit to modify the created OSD.

Right click the added OSD and select Create Copy to make a duplicate of the OSD.

4.2.1.5 Add Test Patterns

The Kompass FX3 Pro offers robust functionality for adding custom test patterns. Users can
flexibly generate precise test patterns based on the actual condition of the current display.

These patterns include precise geometric shapes (suc h as lines, grids, and circles), detailed color
and brightness presentations, ideal for on - site screen debugging.

Step 1 Inthe media library area, right click the blank area or a specific media item, choose  More
Tools > Add Test Pattern to enter the test pattern addition interface.

Figure 4-3 Add test patterns

Upload
o
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Step 2 Inthe Layer Settings and Display Content Personalization  sections on the right, you can
configure the properties of the custom test pattern and change the style of the test patt ern.

Each setting will display a real -time test effect image on the left.

Step 3 Click OK to complete the settings and add the custom test pattern. After the addition, the test
pattern will appear in the media library.

4.2.1.6 Media Optimization

When the size of the adde d media file exceeds the graphics card processing capabilities, the
media type will display as Optimizable . For convenience in subsequent use, you can use this
function to modify the media resolution in advance.

E Note

Only videos and images can be optimized, a nd the resolution must be even numbers.

Step 1 Inthe media library, select the image or video you need to optimize.
Step 2 Right click the media file and select Media Optimization
Step 3 Set the media optimization options based on the interface instructions.
Figure 4-4 Media optimization
Media Optimization

Coding Self-Adaptive
Quality Medium

Code Rate Self-Adaptive

Frame Rate Self-Adaptive

Audio AAC{Recommended)

Resolution W 3840

GPU Acceleration

Cancel Optimize

Coding: Set the video encoding format, supporting  Self- Adaptive , h264 , h265, vp9, and

hap formats. When setto Self- Adaptive , transcoding follows the original video encoding.

Quality: The image quality after video transcoding can be setto  Low, Medium , or High.
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1 Low: The transcoded video is more blurred compared to the original.

1 Medium: The transcoded video quality is between high and low.

T High: The transcoded video is close to the original quality.

Code Rate: Set the video bitrate after tra nscoding, supporting Self- Adaptive and Custom .
T Self- Adaptive: Consistent with the original video bitrate

T Custom: Input the desired bitrate for transcoding.

Frame Rate: Set the frame rate of the media after optimization. The options include  Self-
Adaptive , 24,25, 29.97, 30, 50, 59.94, 60, and 120.

Self- Adaptive : Matches the original video frame rate.

Audio: Set the audio transcoding mode, supporting AAC, Copy, or No Audio .

T AAC: Re encode the original audio in AAC format.

T Copy: Retain the original audio in the video.

T No Audio: Output video without audio.

Resolution: Set the resolution size of the transcoded video.

T W: Set the horizontal size. Default: 1920; recommended maximum: 8192.

T H: Set the vertical size. Default: 1080; recommended maximum: 8192.

T If set resolution exceeds the original media, it defaults to the original resolution.

GPU Acceleration: Toggle GPU acceleration during media optimization.

Step 4 Click Optimize to automatically perform optimization.

4.2.2 Manage Media

4.2.2.1 Rename Media

Right click the media file or folder you want to rename, select Rename to activate the editing

for the media or folder name, and enter a custom name.

Double click the media or folder name area to activate the media or folder name editing, and

enter a custom name.
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4.2.2.2 Delete Media

There are the following ways to delete the media.

-

In the media library, select the target media and click
In the media library, right click on the media you want to delete and select  Delete.

When deleting a folder, all media within the folder will be deleted as  well.

4.2.2.3 Manage Media

You can create folders to categorize and manage the imported media.

Right click the media library area, select Insert Folder and enter a folder name to create a

folder.
Select the media files and drag them into the folder to categorize  and manage them.

Hold down the Shift key or Ctrl key, select the files you want to manage in a new folder.
Right click and select Insert Folder , and enter a name for the newly inserted folder to

complete the file categorization and folder creation.

Drag the file or folder to sort it.

4.2.3 Manage Input Sources

The input sources support streaming media sources, NDI input sources, capture card input
sources and more. The system automatically recognizes and adds capture card input sources,

which can be disabled as needed.

4.2.3.1 Add Capture Card Sources

The software supports acquiring input source images via capture cards. The capture cards listed
in the following table have undergone rigorous compatibility testing to ensure a stable and

reliable experience.

www.novastar.tech 39



NOVASTAR Kompass FX3 Pro Multimedia Playback Software

Advanced Edition User Manual

Table 4-1 Recommended capture cards

Brand Model Connector Type
Blackmagic BL1 Gss§2Z2a qg w%Ob y§ Z| 4x12G-SDI
Design (BMD) .
BL1 Us8Z0 yS§8ZS§8 ¢ L1 bQ 1x6G-SDI, 1x HDMI 1.4, choose one
YUAN High-Tech SC542N4 4x HDMI 1.3
Chuangshi Zhixing | CSZX 8002HDMI_20220430 2x HDMI 1.3
Tianchuang TC-410N2 2x HDMI 1.4
Hengda
TC542N2 2x HDMI 1.3
Baoshi SC0720 4x HDMI 2.0

Figure 4-5 Capture card connection

Video Source

Capture Card Media Server

Prerequisites

The capture card and its drivers are installed on the media server with Kompass FX3 Pro.

Connect the input source to the capture card using the appropriate video cable.

Operating Procedure

Step 1 Select the Input Sources tab on the right pane to enter the input source interface.
Step 2 Click Capture Device to expand all input sources connected to the capture card.

The system will automatically recognize and name all connected input sources. You can double

click the name to modify it.

Step 3 Click the video format dropdown below the name to modify the video format captured by the

card.

¢S8kLb OBOZET L OL T 071 | NISP TFL §:
and yuyv422 is the video sampling rate.
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Table 4- 2 Sampling rate description

Format

Description

Common Uses

yuyv422

YUV4:2:2 format, with interlaced
storage of brightness (Y) and chroma
(UV) components, sharing a set of UV

values for every two pixels

Camera capture, video conferencing,
video capture cards

rgb32

32- bit RGB format (with Alpha
channel), where each pixel occupies 4
bytes (R, G, B, A)

Graphics processing, screen capture,

image editing

rgh24

24-bit RGB format, with each pixel
occupying 3 bytes (R, G, B), no Alpha

channel

Image storage, video rendering,

computer vision

nvl2

YUV4:2:0 format, with separate storage
of brightness (Y) and interlaced
storage of UV components (half
resolution)

Video codec H.264/H.265, GPU
accelerated processing

uyvy422

YUV4:2:2 format, similar to YUYV422
but with a different byte order (UYVY
instead of YUYV)

Video capture, digital video interfaces
(e.g., HDMI capture)

Click e or @

at the top right of the capture source to

enable or disable the capture card

thumbnail view. Click the icons next to Capture Device to enable or disable all capture card

thumbnail views.

4.2.3.2 Add Streaming Media

The streaming media can be added as an input source. RTSP and RTMP formats are supported.

Step 1 Click the Input Sources tab on the right pane to enter the input source configuration interface.

Step 2 Click +

Media to pop up the streaming media adding dialog box.

next to Streaming Media or right click the blank area and select Add Steaming
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Figure 4-6 Add stre aming media

Add Streaming Media

Mame Streaming Media 1

Network URL

Cancel OK

Step 3 Enter the name of the streaming media.
Step 4 Enter the media path.
The media path must start with rtsp:// or rtmp://.

Step 5 Click OK to complete adding the streaming media.

4.2.3.3 Add NDI Sources

After the successful installation of Kompass FX3 Pro , it includes the installation of the NDI
configuration tool - NDI Sender. Once NDI Sender is enabled, Kompass FX3 Pro will
automatically search for all computers with NDI senders enabled on the current network
segment.

Prerequisites

The computer with the NDI sending device must be on the same network segment as the
media server or host where Kompass FX3 Pro is located.

Ensure that the computer with the NDI sender can communicate normally with the media
server or host where the Kompass FX3 Pro is located.

NDI Configuration

Step 1 Double click NDI Sender.exe to enable the NDI sender.
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Figure 4-7 NDI Sender interface

@ NDI Sender

Name: | 16005374-P3 SelectROl || ShowRal

n: | Screen:0(1920x1080)

. | Start | | Reset

Step 2 Set the position and size of the screen on the computer to be used as NDI.

There are two ways to set the position and size of the NDI image.
Click Select ROI and hold down the left mouse button to make a selection on the screen.
In the Sent ROI area, precisely set it using the region coordinates and region size.

T x: The horizontal starting position of the top left corner of the NDI image relative to t he

screen.

T y: The vertical starting position of the top left corner of the NDI image relative to the

screen.
T w: The horizontal width of the NDI image.
T h: The vertical height of the NDI image.

After setting up, click Show ROI to view the NDI output screen.
Step 3 Enter the name of the NDI source in the Name section.

Step 4 When the computer outputs to multiple screens, select the screen you want to use as the NDI

display from the dropdown menu in the Screen section.
Step 5 Enter the frame rate of the NDI image inthe FPS section, with a default value of 25.

Step 6 Click Start to complete the NDI Sender configuration.

Add NDI Sources

Step 1 Click the Input Sources tab on the right pane to enter the input source configuration interface.
Step 2 Click + next to NDI or right click the blank area and select Add NDI Media to pop up the
NDI adding dialog box.

The system will automatically search for all sources with NDI sending enabled on the current

network and open the NDI network screen list.
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Figure 4-8 NDI network s creen

Add NDI Media

Refresh Cancel oK

Step 3 Select the NDI network screen you want to add.
Step 4 Modify the name of the NDI source in the Receiver section.
Step 5 Click OK to complete adding the NDI input source.

Click Refresh to retrieve the list of NDI sources on the current network segment again.

4.2.3.4 Add Webpage Sources

Kompass FX3 Pro supports adding the webpages as input sources.
Prerequisites

The computer running the software is connected to the network.
Operating Procedure

Step 1 Inthe Media Library area, select the Input Sources tab.

Step 2 Click + nextto Webpage to open the webpage adding window.
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Figure 4-9 Add webpages

Edit Website URL

Resource Webpagel

Mode MNative =

Website URL (1/30) +Add Tab

Tab1 https://www.bing.com/

Step 3 Enter the desired webpage name in the Resource area.

Step 4 Select the display mode for the added website in the Mode area. The options include Native

and Screenshot .

Native: During playback, the stage editing area does not provide a preview. Instead, it is
displayed directly on the extended screen, and the output image can be controlled using the

mouse.

When the resolution of the added webpage exceeds the processing capability of the media
server's graphic card, it is NOT recommended to use the native mode. Moreover, in native
mode, the same webpage media should not be added to multiple layers within the same

program.

Screenshot: During playback, the software captures the image from the webpage window
and renders it onto the display screen connected to the connector, and allows for the image

to be cropped if needed.
Step 5 Enter the tab name in the left text box in the  Website URL area.
Step 6 Enter the complete domain name in the right text box.
Step 7 Click Add Tab to add a new tab page.
Step 8 Enter the tab name and domain name of the new tab page.

Step 9 Click OK to enter the added website.
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Figure 4- 10 Website page (native mode)

2 Microsoft Bing

/ o3 Qg

If the screenshot mode is selected, when a super -large browser image is added, which exceeds
the processing capacity of a single graphics card on the media server, you can crop the bowser
image to several parts and then mosaick them together in the program to finally display the

whole webpage content.

You can complete the webpage cropping configuration  using the following parameters:
X: Sets the starting horizontal coordinate for the cropping, based on the top - left corner.
Y: Sets the starting vertical coordinate for the cropping, based on the top  -left corner.
W: The horizontal width of the cropped imag e.
H: The vertical height of the cropped image.
Apply: Click Apply to make the parameters take effect.
Webpage Output: Adjust the size of the output webpage by selecting an output resolution.

Inspection: Click Inspection in the upper right corner. The syst em will automatically analyze

the current webpage, and upon completion, the detection results will open automatically.

B Note

If the webpage resolution is too large, drag the thumbnail in the bottom right to select the crop
area.
Hold the spacebar to drag the b ottom right canvas.

Hold the Ctrl key and scroll the mouse to zoom in or out of the bottom right canvas.

Step 10 Click at the top right corner to close the website.
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E Note

When multiple tabs are opened, the tab where you stay on before closing the website will be
used as the input source.

If you opened other website pages and the new page is displayed on the new tab, the
system automatically adds the new tab page.

If you require long -time webpage playback, it is advisable to configure software to
automatically restart at scheduled intervals via Settings > System Settings , in order to

periodically clear the webpage cache.

4.2.3.5 Clear Input Sources

Step 1 Click the Input Sources tab on the right pane to enter the source configuration interface.
Step 2 Right click the blank area and select Clear Input Sources .

Figure 4-11 Clear input sources

Do you want to clear the input sources?

Clear the input sources in use

Cancel

Step 3 (Optional) Select Clear the input sources in use

Step 4 Click OK to clear all input sources except th e capture card.

4.2.4 Output Control

Kompass FX3 Pro allows backend device control through control commands. It is recommended

that only trained professionals perform the operation.

4.2.4.1 Add Output Control

Step 1 Click the Output Control tab on the right pane.
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Step 2

Step 3
Step 4

Step 5

Step 6

Step 7
Step 8

Step 9

Click + in the upper right corner or right click in the blank area and select ~Add Output

Control .

Figure 4-12 Add output control
Control Device

Name  Device Command?2
Device  Custom Device
IP o000
Protocol TCP ©UDP
Port

Type

Encoding

Command
Cancel
Enter the command name in the text box nextto Name.
Choose the target device to be controlled in  Device.
Enter the IP address of the devi ce to be controlled in |P.

After completing the entry, click Test to test the network connection and verify connectivity.

A green box indicates a normal network connection between Kompass FX3 Pro and the

target device.

A red box indicates a network connect ivity issue, necessitating troubleshooting of the

network configuration or hardware.
Select the communication protocol, either TCP or UDP.
When Custom Device is selected, the communication protocol can be configured.
Enter the external control port number in Port.
Choose the command's control type in  Type.

Select the encoding format of the command in  Encoding . Options include HEX, ASCII, and
JSON.

When Custom Device is selected, the communication protocol can be configured.
HEX: The command is in hexadecimal format.
ASCII: The command is text- based.

JSON: The command is in json format.
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Step 10 Enter the specific command corresponding to its type in  Command .
For the JSON encoding type, click Browse to upload a JSON file.

Step 11 Click OK to complete adding a command.

Once added, drag the output control to the program or timeline to add and send commands.

4.2.4.2 Edit Output Control

Once output control has been added, it can be edited and modified as needed.

Modify Output Control Command Informati on

Step 1 Right click the output control command to be modified and select  Edit Output Control  to open

the editing interface.
Alternatively, double click the control command to access the interface.

Figure 4- 13 Edit output control

Control Device

Name  Device L’_’ammandﬂ

Device H Series Video Wall Splicers
IP10.10.153.56
Port 6000
Type  Play Presets
Command  Command 1

Cancel OK

Step 2 Make the necessary modificatio ns to the information of the command.

Step 3 Click OK to complete the command modification.

Rename Output Control Commands

The name of an output control command can be changed in the following ways:
In the modification interface, give a new name inthe Name field.

Right click the command to be renamed in the Output Control tab interface, select Rename,

and enter the new name.
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4.2.4.3 Delete Output Control

Delete Single Command

Click the output control command to be deleted inthe  Output Control tab interface, then

m)

click at the top right to delete it.

Right click the command and select Delete to delete it.

Delete Multiple Commands

Right click the blank area in the Output Control tab interface and choose Clear Output

Control to delete all added commands.

ar

Press and hold Ctr| or Shift while selecting multiple commands, then click to delete the

selected commands.

4.3 Edit Outputs

Before editing the outputs, in order to ensure synchronization of the outputs, please refer to
the procedure described in Graphics Card Mosaic to complete the graphics card output mosaic

configuration.

Kompass FX3 Pro supports output editing, allowing you to mosaic multiple output connectors

for seamless output.

In the menu bar, navigate to Output > Screen to enter the output management interface.
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Figure 4- 14 Screen management

Qutput List

~ £9 10.41.9043 (16005558-L)
~ Output1 (1920x1080)
Output1-1 (1920x1080)

Output4-1 (1920x1080)

Outputl-1

Output3-1

Output Management
Link Management Edge Blending
el @ %2 B B Properties
Name Outputl
Bind Output None
Resolution None
Size W 1920 O
Dyn. SDR

v Qutput Segmentation

Output2-1

Outputl-1

ODEODMEEHDE 2 +

Outputd-1

* Sub-OQutput Properties

— . The output connection for the selected connector is already enabled. Click to

disconnect the current connector's o utput connection.

current connector.

— : The output connection of the selected connector is disabled. Click to connect the

LT:I : The output identify function is enabled. Click to disable it.

© N U & O

: Delete the selected output.

: The output identify function is disabled. Click to enable it.

: Revert the most recent or multiple actions to restore the content to its previous state.

: Reinstate actions that were just undone.

: Click to hide text display in the stage editing area or screen management. After hiding,

the icon changes to . At this time, the slices in the stage editing area will only show

images, with no text. Click it again to display the text information.

|:|: Click to display the output screens in the editing area with the best perspective.

(g
l-"E’:': Click to restore the editing area to the top left corner.
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: Click to zoom in the editing area.

B: Click to zoom out the editing area.

Press and hold the mouse wheel and drag to move the canvas.

Add and bind outputs automatically

When the software starts, it automa tically detects the graphics card connectors, automatically
adds the corresponding outputs, and completes the output and connector binding in sequence,

displaying them all in the Output List area on the left.

When changing the connection order of the compu ter output connectors and the backend
devices, you can edit the output name, the binding relationship of the physical connector, and

the output resolution in the Properties area on the right.

Add and bind outputs manually

When more graphics cards are insta lled on the control PC or you want to change the connector

quantity in a saved project file, you can select to add the outputs manually.

E Note

At most three screens can be bound.

Click + at the top right of the output list. After the output is added, modify the relevant

information in the Properties section on the right.
Name: Modify the current output name.

Bind Output: Configure the relationship between the currently edited output and the

physical output connector of the actual device.

When binding to a graphics card connector, it will display the graphics card name,

connector, and connector output resolution.

1 1: Indicates the connector number of the graphics cards, where 1 is the first  connector
bO TFiL 1 EOk

oY JLOLOP Th TFL G6OENFSI P 1 EOK
i YOENF &1 P 1 EOk ZbklLuy aZk31 ETLP TiL ZBkLy BO Tr¥|

T Not Recommended: Indicates that this connector is being used for the software
§ZTLOOEI L kS8PNyET
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T NDI Video Output : Outputs the current connector display via NDI.

T Spout Video Output: Outputs the current connector display via Spout.

E Note

When Bind Output is set to NDI Video Output or Spout Video Output , the current connector

does not support output.

Resolution: Displays the output resolution of the connector. When  Bind Output is set to a

graphics card connector, this shows the physical resolution of the graphics card connector.
Size: Modify the output size.

Dynamic Range: Configure the video output format, supporting bothn  SDR and HDR. When
set to SDR, the video is output in the SDR format; when setto HDR, it is output in the HDR

format.

4.4 Split Outputs

4.4.1 Output Segmentation

Output segmentation divides an output into multiple sub - outputs, enabling the splitting and
reassembly of the display image, which facilitates the construction and management of irregular

screens.

Step 1 Navigate to Output > Screen, then select the output in the output list on the left or click an

output in the Edit area.

Step 2 In the Output Segmentation  section on the right, select the desired segmentation method from

the listed ones.
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Figure 4-15 Output segmentation

Qutput Management
Link Management Edge Blending
Output List - < B Properties

v 8 10.41.90.43 (16005558-1) aF Name  Output1
v Output1 (1920x1080) O Bind Output None
Output1-1 (960x540) Resolution None

Output1 X Size W 1920

DynamicR.. SDR

~ Output Segmentation

Outputl-1 Outputl-2
Outputd-1 (1920x1080)
Outputl-1 Outputl-2

Outputl-3 Outputl-4
Output2-1

Qutputl-3 Outputl-4
ODBOBDDE 2+

Position X 0

Y o "

H 540

Size W 960

Rotate 0°

Output3-1 Outputd-1 ~ Sub-Output Properties
Name Outputi-1
Bind Input None Apply to All

Position X 50

Size W 960

Rotate 0°

. Layout:

. 1x sub- output

: 2x sub- outputs in horizontal direction

: 3X sub- outputs in horizontal direction

. 4x sub- outputs in horizontal direction

: 2x sub-outputs in vertical direction

: 4x sub- outputs in a grid pattern

: 3x sub- outputs in vertical direction

: 4x sub-outputs in vertical direction

: Custom sub- outputs

+ (> B OE B B8 0

[ : Add a sub- output. Add one sub -output with each click, and use the size of the first

sub- output for the addition.

o To

[ : Delete the selected sub - output.

. Output segmentation control:
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T (D: Revert the most recent or multiple actions to restore the content to its previous

state.

1 C) : Reinstate actions that were just undone.

iy
T l:Ql: After moving the ¢ anvas, click this button to reset the canvas to the top - left

corner.
[ : Click to zoom in the output area display.
T IEI: Click to zoom out the output area display.

T @: Click to enlarge the sub - output and expand it to the editing area. After expansion,

click Q in the top - right corner of the editing area or click Restore Canvas to revert

the zone.

. Press and hold the mouse wheel and drag to move the position of the canvas.

4.4.2 Sub- Output Rearrangement

Sub- output rearrangement refers to reorganizing the output segmentat  ions as needed.

Under the Screen tab, drag the sub - outputs to rearrange them.

Figure 4- 16 Rearrange sub-outputs

Output Management
Link Management Edge Blending
Output List @ “ Properties
~ Qutput Properties
Name Outputl
Qutput1-1 (960x540) Bind Output None
Output1-2 X! Resolution None

w 1920 7

~ Output Segmentation

Outputl-1 Outputl-2 Outputl-1 Outputl-2

QOutput2-1
P Outputl-3 Outputl-4

Outputl-3 Outputl-4

ONDBODBEDDE 2+

Position X 0 Y o

. H 540

Size W 960 °
Rotate 0°

~ Sub-Output Properties
Name Outputl-1

Bind Input None v Apply to All

Position X 50

Size W 960
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In the Sub- Output Properties section on the right, modify the relevant information for the

selected sub- output.
Name: Modify the sub - output na me.

Bind Input: Bind the current output or sub - output to the corresponding layer. Once bound,

the sub - output will consistently display the content from the associated layer.

Apply to All: Apply the layer from the current bound input to all sub - outputs of t he current

output.

Position: Adjust the position of the sub -output on the screen based on the top left corner of

the stage.

T X: The horizontal starting coordinate of the sub - output or output on the entire stage
T Y: The vertical starting coordinate of the sub - output or output on the entire stage
Size: Set the size of the sub- output.

T W: The width of the sub - output or output

T H: The height of the sub - output or output

Rotate: Adjust the rotation angle of the sub - output or output in a clockwise direction.

4.5 EDID Quick Tool

Once the output configuration is complete, use the EDID Quick Tool to lock and export all
bOTNOT FBaBP

T
Right click the EDID Quick Tool A icon in the desktop's lower - right toolbar to open the

menu.

Figure 4-17 EDID tool
Lock EDID Ctrl+Alt+Shift+L
Unlack EDID Ctrl+Alt+Shift+U

Export EDID Ctrl+Alt+Shift+E

i5=/Language Ctrl + Alt+Shift+5

About

Exit

Lock EDID: Instantly lock all connected output connector EDIDs to prevent display order
confusion or resolution anomalies due to connector reconnection, signal interruption, or

system reboot. Shortcut: Ctrl+Alt+Shift+L.

www.novastar.tech 56



NOVASTAR Kompass FX3 Pro Multimedia Playback Software

Advanced Edition User Manual

Unlock EDID: Unlock all previously locked connector EDIDs . Shortcut: Ctrl+Alt+Shift+U.

Export EDID: Instantly export EDIDs from all connected output connectors to the local
desktop, automatically creating an EDID folder. Shortcut: Ctrl+Alt+Shift+E.

Language: Switch the EDID Quick Tool menu interface language bet ween English and
Simplified Chinese. Shortcut: Ctrl+Alt+Shift+S.

About: View version information for the EDID tool.

Exit: Exit the EDID Quick Tool.

4.6 Configure Edge Blending

Edge blending is the method of finely overlapping the projected images from multiple
projectors at the edges, using software to blend the images to eliminate seams and adjust

overall brightness and resolution.

Navigate to Output > Edge Blending to enter the edge blending interface.

Figure 4-18 Edge blending interface

Output Management

Link Management Screen

Output List Blending Editing Area B @ & Properties

v Properties

v 9 10419 6005558- ~ .
" 2 output2-1 d,tputzz > Show Cont... @
output1-1 ® € " 5 Content [ ] 1 H H N
v output (1920 ® & output?3  output2-4 Scope O Blend zone independent of geometry adjustment
it Eibue ) = . GridColor [ [C] I M W B W 7 1 #1617
" s R Line Width ol 5)
y y ; kY Export/Imp... Export Blending Data  Import Blending Data
ut3 ( ® & . . v Geometry Adjustment B 4

Optical Adjustment Layer

~ outputé (1920
outputd-1 (1920x10...

Perspective @@
Mode Linear
Position X ¥
Anchor/Ve... @ Sync screen display
split B Horizontal E Vertical
Template [ tines [l O W W @ &
> 3D Editing Area Stepping 2 S
Guideline @

v Blend Zone

Select the target o utput in the Output List area on the left or click the output connector in the

Edge Blending Editing area in the middle.
In the Properties area on the right, configure the related parameters.
Show Content: Show or hide the display of the current editing co  ntent.

Content: Select the display content of the selected output.

T E: The software interface shows the playback content of the current connector.
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I Solid color blocks: The software interface shows the selected solid color.

Scope: Configure whether the curren t blend zone configuration is applied base on the
geometric adjustment.

1 Unchecked: Edit the blend zone based on geometry adjustment, with both the blend

zone and geometry adjustment configuration effective.

T Checked: Independently edit the blend zone, adjusting on the original image without

the effects of the geometry adjustment layer.

Grid Color: Configure the color of the grid on the output screen. You can choose from preset

colors or click 7 on the right to select from the screen display.

Line Width: Set the width of the grid lines on the output screen, ranging from 1 to 10. Click

O to reset the line width setting.

Export/Import: Export the blending configuration data into a separate file, or import the
exported blending data file into the system.

T Export Blending Data: Export the configured blending data in the current environment
to your local computer.

[ Import Blending Data: Import the blending data into the system to quickly complete
edge blending configuration.

4.6.1 Geometry Adjustment

Step 1

Step 2

Geometry adjustmen t solves the mismatch issue between projected images and the screen
caused by improper projector placement, projection angle deviation, or lens distortion. Precise
geometric adjustments ensure the image perfectly fits the screen, achieving clear, accurate
projection that meets various display needs. Users can select the most suitable mode based on
the actual projection environment and creative needs, even achieving perspective cropping for

ideal visual presentation.

Select the output in the Output List area on the left or click the output connector in the  Edge
Blending Editing area in the middle.

_I_

In the Properties area on the right, click next to Geometry Adjustment

The supported adjustment types include Linear and Curved .

Linear: A geometry adjustment method based on linear transformation. It deforms the image

by simply moving vertices.
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Step 3

Curved: A geometric deformation achieved through a non -linear mathematical model. It
supports complex deformations in local areas and allows differentiated adjustmentst o
different parts of the image.

The system will add a Geometry Adjustment Layer x ~ with adjustment parameters.

In the Geometry Adjustment area, click E and @ on the right to add a grid to the canvas

editing area and output image.
E: Add a grid to the select ed output or sub -output in the canvas editing area.

@: Synchronize and display the grid lines of the current output on the screen.

In the Edge Blending Editing area, click the vertex's anchor point and drag it to adjust the
output image.

Figure 4-19 Anchor editing

.
utput2-k Q ,tpu{
4
L4 L

rs

output2-3 output2-4

On the right, set and edit anchor points in detail.
Perspective: Enable or disable perspective mode during adjustments.
Mode: Set the anchor point adjustment mode. Options include Linear and Curved .
Position: Adjust the anchor point position.

T X: Set the horizontal coordinate of the selected anchor point, relative to the horizontal
distance from the origin of the screen.

T Y: Set the vertical coordinate of the selected anchor point relative to the vertical
distance from the origin of the screen.

Anchor/Vertex: Set whether the anchor point editing process is simultaneously displayed on
the output screen.

Split: Split the connector screen horizontally and vertically, and after splitting, you can edit

the anchor points in each direction respectively.

1 Horizontal: Click / B to increase or decrease split points horizontally.
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T Vertical: Click / B to increase or decrease split points vertically.

1 Double click the edge to freely add anchor points.

1 Select an added anchor point and press the Delete key to remove it.

Lines: Set the color of the lines between the anchor points.

Stepping: After selecting an anchor point, adjust its position using the arrow keys on the
keyboard. Each keystroke moves the anchor point a distance ranging from 1 to 10, with a
default val ue of 10.

Click O on the right to restore the set value to its default.

Guideline: After selecting an anchor point, enable or disable the guideline between the

anchor point and its adjacent anchor points.

After enabling the guideline, you can set the line  color using the following methods.

T Click / to select the line color.
T Click the color block and choose a color from the pop - up color picker.
T Enter the color value in the text box to set it to the specified color.

T Width: Set the size of the guideline, with a value ranging from 3 to 10, and a default

value of 3.
Step 4 Click the other anchors to make the necessary settings for them.

Press and hold the Ctrl key and click other anchor points to select multiple anchors at once.
After holding the Ctrl key, drag the selected anchor points to modify multiple anchors

simultaneously.

Step 5 Click + next to Geometry Adjustment to continue adding geometry adjustment layers.

When there are multiple geometry adjustment layers, click 1\ or \I’ next to the layer name

to adjust the order.

Oth er Operations

O : Click to restore the selected geometric adjustment parameters to their default values.
: Click to export the selected geometry adjustment parameters to a local file.

: Click to import geometry parameters saved locally, replacing the curr  ently selected

geometry parameters.
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™
N2

: Click to move the selected geometry adjustment layer up.

: Click to move the selected geometry adjustment layer down.

4.6.2 Blend Zone

Step 1

Step 2

The blend zone is a transitional area formed by setting specific parameter when using m ultiple
projectors to combine and project an image. It eliminates or reduces seams or overlaps at the
edges between different projectors, ensuring a smooth transition between images for a more
seamless and natural projection effect.

Select the output in th e Output List area on the left or click the output connector in the  Edge
Blending Editing area in the middle.

+

In the Properties area on the right, click next to Blend Zone and select the target position

for the blend zone.

Left: Add a blend zone to the left side of the selected area.
Right: Add a blend zone to the right side of the selected area.
Top: Add a blend zone at the top of the selected area.
Bottom: Add a blend zone at the bottom of the selected area.

Outer: Add a blend zone around the selected area.
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Figure 4-20 Add blend zone

~ Blend Zone

Blend Zone1

Position X 864
Size W 96

Anchor Edit @

Black Level... @

Zone Border ([ On-screen display zone border

Gamma o

Curve Adjust = Curve Adjust

Step 3 Adjust the parameters of the blend zone as required.

Position: Adjust the position of the blending zone using X and Y coordinates, relative to the

origin of the image in horizontal and vertical directions.

In the Edge Blending Editing area, hover the mouse over the blend zone, hold the left

mouse button and drag to quickly adjust the position of the blend zone.
Size: Set the size of the blend zone.

1 W: The horizontal width of the blend zone

T H: The vertical height of the blend zone

T In the Edge Blending Editing area, place the mouse over the vertex of the blend band,

click and hold the left mouse button, and drag to quickly edit the size of the blend zone.

Anchor Edit: Enable or disable the anchor point editing function for  the four vertices of the
blend zone.

Position: When Anchor Edit is enabled, this parameter can be configured to provide detailed
position information for the four anchor points of the blend zone, using the top left corner of

the output image as the refere nce.
Black Level Compensation: Enable or disable the black level compensation function.

Black level compensation refers to enhancing the brightness of non - overlapping areas in a

dark field environment to offset the overlapping bright zone, thereby unifying the brightness
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of the non - overlapping image with that of the overlapping bright zone for a visually smooth

transition.
Zone Border: Turn the display of the blend zone border on or off on the output screen.

Gamma: Adjust the Gamma parameter of the blend zo ne, with a range of 1.0to 5.0 and a
default value of 2.2.

Curve Adjust: Click Curve Adjust to open the blend curve adjustment interface.

T Channel: Select the blend channel to adjust. Options include White, Red, Green, and

Blue.
White: Adjust the blend ef fect uniformly across all color channels.

Red, Green, Blue: Adjust the blend curves for red, green, and blue individually to

address color differences in projections.
T Curve Type: Two modes are provided: Preset and Custom.

Preset: Predefined blend curve templates for quick adaptation to common projection
needs. Templates include Bezier, Triangle , and Exponential , which can be fine tuned
using the Parameter below.

Custom: Allow manual dragging of curve nodes for free adjustme nt. Click Reset next to
Template to reset the curve.

1 Gamma: Adjust the non - linear brightness response curve, affecting the curvature of

brightness transitions in the blend zone. Range: 1.0 5.0 (default: 2.2).

1 Gradient Angle: Define the transition direction of the blend zone.

i Click 2

next to a parameter to reset it.
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More Operations

© / 7" : Show or hide the blend zones.

T Click the icon at the top of a blend zone to show or hide all blend zones.

T Click the icon next to a specific blend zone to show or hide only the  selected blend zone.

&/ &': Lock or unlock the blend zones.
T Click the icon at the top of a blend zone to lock or unlock all blend zones.

T Click the icon next to a specific blend zone to lock or unlock only the selected blend

zone.
+ : Click to add a blend zone.

E : Click to export the selected blend zone to a local file.

E : Click to import a blend zone from a local file, replacing the currently selected blend

zone.
(D: Revert the most recent or multiple actions to restore the content to its previous state.

C): Reinstate actions that were just undone.

4.6.3 Blend Templates

After completing the geometry adjustment and blend zone settings for an output or sub -
output, save the parameters as a blend template. This template can be applied to other outputs

or sub-outputs fo r quick adjustments.

Save Templates

Step 1 Navigate to Output > Edge Blending > Output List , and select the target output or sub -

output.

Step 2 Inthe Properties section on the right, complete the geometry adjustment and blend zone

settings for the selected output or su b-output.

Step 3 Click + in the Template section below to add a blend template.
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The template can save one or more settings from the geometry adjustment and blend zone

configuration.

Rename Templates

Right click the added template, select Rename, enter the new nam e, and click elsewhere or

press Enter to confirm.

Load Templates

Step 1 Navigate to Output > Edge Blending > Output List , and select the target output or sub -

output.

Step 2 Click the template to apply the saved template to the selected output or sub - output.

Delete Templates

Delete single template: Right click the added template and select Delete to remove the

selected template.

Clear all templates: Right click the added template and select Clear Templates to remove all

added templates.

4.6.4 Edge Blending Shortcuts

The system provides preset shortcuts for edge blending operations.

Table 4- 3 Edge blending shortcuts

Shortcut Function Description

-, = Output list navigation . -2 Move up in the output list.

. =: Move down in the output list.

. Esc: Exit advanced edit mode.

[,] Geometry adjustment layer . [: Cycle up through geometry adjustment layers.
navigation . ]: Cycle down.

Ctrl+[, Blend zone navigation . Ctrl+[: Cycle up through blend zones.

Ctrl+] . Ctrl+]: Cycle down.

Enter, Esc | Advanced edit toggle . Enter: Enter advanced edit mode.
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Shortcut Function Description

Arrow Anchor point movement Move the selected anchor point up, down, left, or

keys right in fixed stepping.

W, A, S, D | Anchor point selection Move the selection of anchor points up, down,
left, or right.

4.6.5 3D Editing

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10 Select the photo image and click

3D (three - dimensional) editing assists users in seamlessly adjusting the playback effect of
panoramic content to fit various curved screens, such as domes, bowl -shaped, or curved
screens. By simply adjusting the shape and mosaic position within the software, users can
resolve image distortion without repeatedly altering the content. Adjustments can be previewed

in real-time and directly output to projection or LED screens for an immersive experience.
Navigate to Output > Edge Blending to enter the edge blending interface.

In the output list on the left, select the desired output.

In the properties area on the right, click @ next to Geometric Adjustment to enable the
output grid display.
In the Split section, click next to Horizontal and Vertical to increase anchor points.

More anchor points allow for more detailed adjustments, but require greater adjustment effort,

depending on the complexity of the environment.
Once grid settings are complete, select the adjustment mode.

If the output edge is a curved area, set the mode to Curved.

If the output edge is a straight area, set the mode to Linear.
Repeat Step 2 to Step 5 complete settings for other outputs.

Choose an optimal angle to photograph the output area to record the grid lines.
Click > next to 3D Editing Area or E‘ on the right to expand the 3D editing interface.

In the properties area on the right, click + next to Grid Image to add the photo taken in
Step 7.

M

to appl y the grid image to the 3D editing area.
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If the photo is too large, click % to crop the image in the 3D editing area by dragging

vertices. Click OK to finish cropping.

Step 11 Select the output on the left and in the Advanced section on the right, toggle on the Anchor

Edit function.
Step 12 In the 3D editing area, click and drag anchor points to modify their positions.

You can compare and modify according to the grid image. Anchor points can be modified in the

following ways:
Drag and edit the anchor points.
In the Advanced section, fine tune the X and Y values of anchor points.
If the Curved mode is set, select an anchor point and drag its handle to modify curvature.
Auxiliary adjustment settings:
1 Anchor point line: Set the color of lines between anchor points.
T Anchor point stepping: Adjust the stepping distance with keyboard arrow keys.

T Guideline: Enable or disable boundary lines attached to selected anchor points. The

guideline color and width settings are supported.

Step 13 Once one output connection is configured, click other outputs and adjust each one individually.

4.7 Edit Program Layers

Before starting program editing, media files need to be imported into the layers.
4.7.1 Add Program Media

Layers are used to store media files in the program. Click + in the top right corner of the

Program area to add a layer.

E Note

At most 40 layers can be added.

Select the target media file in the media library, click and hold the left mouse button to drag it

to the corresponding layer of the program to add the layer to the program.
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Figure 4-22 Edit program layers

e R
X_Editing

ER B 8

A

E Note

If an encrypted video (.nvf) file is added to the media library, entering a decryption password is
required to play the video when adding it to a program. If the encrypted video exceeds its

encryption duration, it will not be playab le.

4.7.2 Configure Program Media Properties

Configure the basic media properties, playback method, display settings, and image quality

parameters.
Step 1 Click the media in the program to select it.

Step 2 Select the Properties tab on the right pane to enter the media prope rties interface.
Basic

Figure 4-23 Media properties - basic

~ Basic
Name 1
Duration 00:00:09:976
Playback +« 00:00:09:976
Start Time 00:00:00:000

End Time 00:00:09:976

Delay Start 00:00:00:000

www.novastar.tech 68



NOVASTAR Kompass FX3 Pro Multimedia Playback Software

Advanced Edition User Manual

Name: View or modify the media name.
Media: View the media duration.
Duration: Set the playback duration for this media.

T If the playback duration is longer than the media duration, the media  will automatically

replay.

T If the playback duration is shorter than the media duration, the media will play for the

set duration, and any unplayed content will not be shown.

Start Time: Set the start time for media playback. The start time value cannot be  greater

than the media duration value.

End Time: Set the end time for media playback. The end time value must be greater than the

start time value and cannot be greater than the media duration value.

Delay Start: Set the delay duration for media playback, meaning how long after the program

starts the media will begin to play.

Click O next to each parameter to reset the value to default.

Playback

Figure 4- 24 Media properties - playback

End Action Loop O Last Frame 0O Stop 0O Loop Count

Jump No Jump O Program Loop O Next
Transition Cut w
Media Keep @

Volume

End Action: Set how the current media plays after the program ends.

“—
T Loop: Loop the media in the current layer, with an icon ‘= displayed in the top right.

wd

T Last Frame: Stop at the last frame after one playback, with an icon displayed in

TFL TBN OSO6TF T

T Stop: Stop playing after one playback, with an icon displayed in the top right.

AT
T Loop Count: Set the loop count for the current media, with an icon S displayed in

the top right.

Jump: Set how the current media plays after finishing.
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T No Jump: Do nothing after the media finishes playing.

T Program Loop: The media plays in a loop.

g

T Next: Jump to the next program after playback, with an icon displayed in the top
right.

If a specific program is set for jumping, here the group's name and the program name

Ed

after jumping will be displayed, with an icon displayed in the top right of the

media.

Transition: Set the transition effect for switching media in the program layer. Currently only
supports Cut.

Media Keep: When on, the program resumes from the last played position; when off, the
media restarts from the beginning.

)

Volume: Adjust the output volume of the media. Click to mute the media.

Graphics Card Mapping

Image

Figure 4-25 Media properties  GPU mapping

Local

In Use G1

GPU Aut

Device: The media is output from this device.
In Use: View the graphics card currently used by the media.
GPU: Set the graphics card for rendering the selected media.

Check Auto Select for the system to choose automatically, or uncheck to manually select a
graphics card. Click Apply to complete the graphics card switching.

Figure 4-26 Media properties - image

v Image

Fip OH OV

w
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Color

Flip: Configure the media image flipping.

Uncheck the checkboxes for H and V and the output image will be displayed normally

without flipping.

T H: Flip the output image horizontally.

T V: Flip the output image vertically.

Fill: Select the way how the content of a layer is displ ayed.

T Fill: The media image fills the entire layer.

T Proportional: The layer image is scaled proportionally and displayed within the layer.

Accurate Seek: Enable this feature to quickly jump to a specific time point in a video or audio

file without needing to gradually drag the progress bar to search.

Y/C Stretch: When enabled, the bright areas of the output image become brighter, and the

dark areas become darker.

Figure 4-27 Media properties - color

+ Color

Saturation

Brightness: Adjust the overall brightness of the o utput image. The value range is -100 to
100, with a default value of 0.

Contrast: Adjust the overall contrast of the output image. The range of valuesis  -100 to 100,

with a default value of 0.

Opacity: Adjust the opacity of the output image, with 0% being  completely transparent and
100% being opaque. The default value is 100%.

Hue: Adjust the color offset of the output image. The range of valuesis  -100 to 100, with a

default value of 0.

Saturation: Adjusts the vividness of colors of the output image. The value range is - 100 to
100, with a default value of 0.

Click 2

next to each parameter to reset the value to default.
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Crop
Figure 4-28 Media properties - crop
v Crop
Mode Stretch ~
Crop By [ Proportional O Pixel
Mode: Select the cropping method.
T Stretch: Scale up or down the output image.
T Crop: Crop the output image.
T Proportional: Scale down the output image proportionally.
Crop By: Set the parameter unit for cropping.
T Proportional: The proportion of the image cropped from the entire image
T Pixel: The pixel dimensions for cropping the image
T: Set the size of the area at the top of the media image that is cropped.
B: Set the size of the area at the bottom of the media image that is cropped.
L: Set the size of the area at the left of the media image that is cropped.
R: Set the size of the area at the right o f the media image that is cropped.
Borders

Figure 4-29 Media properties - borders

v Borders

Color @

Unit Proportional O Pixel

Width O

Color: Configure the border color of the media.

Toggle the switch to activate the border function for the media.
Set the border color using the following four methods.

1 Click the color picker tool and click to select the desired color.

1 Click the color block and select a color in the pop -up box.
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Keying

1 Enter the color code value after the # symbol.

] Double click the values next the RGB values and enter the value for each RGB

component to precisely specify the color.
1 Modify the value nextto A to adjust the opacity of the borders.
100 is fully opaque, and 0 is completely transparent.
Unit: Set the size unit of the border.
T Proportional: The border size as a percentage of the media size
T Pixel: The border size in pixels
Width: Set the width of the borders.

T Proportional: Adjust the border width by setting the border size as a percentage of the

media size, ranging from 0% to 100%.

T Pixel: Adjust the border by specifying how many pixels it occ upies to set the border
width, ranging from Opx to half the minimum of either the width or height of the media.

Figure 4-30 Media properties - keying

Color: Key out the specified color from the selected media.

Toggle the switch to activate the key ing function for the media.
There are four methods for specifying the keying color.

T Click the color picker tool and click to select the desired color.
T Click the color block and select a color in the pop -up box.

T Enter the color code value after the # symbol.

] Double click the values next the RGB values and enter the value for each RGB

component to precisely specify the color.

Matte Strength: The higher this value, the stronger the keying range/color correction. When
you need to accurately key out a col or in an image, it is recommended that this value is set

to smaller than 10%; in other cases, more than 50% is recommended.
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. Shadow Adjust: The higher this value, the cleaner the noise areas in the shadow of the

foreground are keyed out.

4.7.3 Configure Program L ayer Properties

Select a layer, and navigate to the Properties tab on the right side to configure the layer

properties.

In the layer properties, the properties of all media within the layer can be adjusted.

Figure 4-31 Layer properties

~ Basic
Name
Control O Close O Lock
Volume
¥ GPU Mapping
Device cal
GPU Auto Select
v Image
Fip OH OV

Fill Fi

~ Color
Brightness
Contrast
Opacity
Hue | — )

Saturation e———— o

~ Sound Channel Mapping

ugh

Sound Card - FULL HD (

Channel

Insert Layer Above Insert Layer Below

Delete Layer

Clear Media
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Area Function Description
Basic Layer name View and modify the layer name.
Layer control Set whether the layer is visible or locked

. Close: Close all media visuals in the layer and only

play the media audio.

. Lock: Once the selected layer is locked, you cannot
add programs to, delete media from, or perform other

actions on that layer for other programs.

Layer volume Adjust the media output volume of this layer.

Click q)) to mute the all media in that layer.

GPU Mapping Device The media is output from this device.

GPU Set the graphics card for rendering the selected media.

Check Auto Select for the system to choose
automatically, or uncheck to manually select a graphics
card. Click Apply to complete the settings.

Image Flip Configure the all media image flipping within  this layer.

Uncheck the checkboxes for H and V and the media

image will be displayed normally without flipping.
. H: Flip the media image horizontally.

. V: Flip the media image vertically.

Fill Select the way how the content of a layer is displayed.
. Fill: The media image fills the entire layer.

. Proportional: The layer image is scaled proportionally

and displayed within the layer.

Color Brightness Adjust the overall brightness of the layer image. The

value range is - 100 to 100, with a default value of 0.

Contrast Adjust the overall contrast of the layer image. The

range of values is - 100 to 100, with a default value of 0.

Opacity Adjust the opacity of the layer image, with 0% being
completely transparent and 100% being opaque. The
default value is 100%.

Hue Adjust the color offset of the layer image. The range of
values is - 100 to 100, with a default value of 0.

Saturation Adjusts the vividness of colors of the layer image. The
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Mapping

Area Function Description
value range is - 100 to 100, with a default value of 0.
Sound Channel Passthrough When the backend audio device is a surround sound

system, Passthrough must be enabled. Once set,

restart the software for changes to take effect.

. On: In program management, select the media and
choose the audio track under Properties > Sound
Channel Mapping > Sound Track . Once turned on,
non- Dolby audio media will be unable to output

audio.

. Off: No need to set the sound track, and audio output
proceeds directly. In this case, Dolby audio media will
not output properly through the surroun  d sound
system.

Layer Channels

Set the number of audio signal tracks in the layer.

Sound Card Choose which sound card on the current device to use
for audio output.
Channel Control the signal mapping and mixing between

channels. Click the corresponding cells in the audio
matrix to map input and output channels.

Insert Layer Above

Insert a layer above the current layer.

Insert Layer Below

Insert a layer below the current layer.

Delete Layer

Delete the current layer and the data within it.

Clear Media

Clear all data in the layer.

4.7.4 Context Menu of Program Layer Media

Right click the layer media to display the context menu.

www.novastar.tech

76




NOVASTAR Kompass FX3 Pro Multimedia Playback Software

Advanced Edition User Manual

Figure 4-32 Layer media context menu

Program  Timeline

ross Program Continuation

Rename

E Enable Media Keep
. Copy

&
P& Cut

Playback )
- Copy Properties

Locate Media
Access File Location

Delete Media

Play: Play the media in the current layer.
Pause: Pause the media playback.
Stop: Stop the media playback.

Cross Program Continuation: The same media file plays on the same layer across multiple
consecutive programs. When switching programs within the continuous program range, the

media plays normally without interruption or resta  rting.

Cancel Continuation: Once Cross Program Continuation is set, this function becomes

available, cancel media continuation across programs.
Rename: Change the name of the media in the program.

Jump: Set the switch mode after the current media has finis hed playing.

P 4
T Media Loop: Loop the media in the current layer, with an icon <« displayed in the

upper right corner of the layer.

1 Last Frame: When the current media playback is completed once, it stops at the last

xd

frame. After the setting is completed, an icon is displayed in the upper right corner

of the layer.

T Stop: After the current media plays once, stop playback and display an icon in the

upper right corner of the layer.
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T Program Loop: When the media playback ends, the program restarts.

T Next Program: After the current media finishes playing, it will automatically jump to the

next program, with an icon M displayed in the upper right corner of the layer.

T Jump to Specific Program: After the current media finishes playing, automatically jump

Ed

to the specified program, with an icon displayed in the upper right corner of the

layer.

T Apply to All: Apply the current media jump mode to  all other media in the current layer.

E Note

When a program has multiple media with different skip modes set, the skip mode of the media

that finishes playing first will take precedence.

Media Keep: Once enabled, when switching back to the program, this media  will resume

playing from where it left off.

Cancel Media Keep: After cancelling the media keep, when switched to this program, the

media will restart from the beginning.
Copy: Copy the currently selected media and media properties. Shortcut key:  Ctrl +C.

Cut: Cut the currently selected media or media properties. After cutting, the layer media in

this program will be deleted. Shortcut key: Ctrl +X.

Paste: Paste the copied or cut media and media properties into the selected program.
Shortcut key: Ctrl +V.

Copy Properties: Copy the currently selected media properties, including media properties

and media slice properties.

Paste Properties: Quickly modify media properties in other programs by pasting the selected

media properties to the media in other programs.
Locate Media: Find the media in the media library.
Access File Location: Open the storage location of the current media on the media server.

Delete Media: Delete the currently selected media.

4.7.5 Configure Program Properties

In the program management area, select the desired program. On the right pane under

Properties , you can modify the program properties.
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Figure 4-33 Program properties

~ Basic

Name

v Play

Keep @

Transition Fade
Slice O Lock

~ Image

Brightness

Contrast

Insert Program Before

FadeIn 0.5s Fade Qut 0.5s

o

P1 ~ Apply to All  Create Copy

o
o

Insert Program After Delete Program

Table 4-4 Program properties

Area Function Explanation

Basic Program name View or modify the program name.

Play Keep media After enabled, when the program switches back, it will
continue playing from the last position; after disabled,
when the program switches back, the media will start
playing from the beginning.

Transition effect Set the transition effect for program switching. The
options include Cut and Fade. For the fade in and fade
out transitions, you can set the fade duration, with the
default value of 0.5s.

Slice layout . Lock: Lock the slice layout style in the selected

program.

. Apply to All: Apply the slice layout style from the
selected program to all other programs.

. Create Copy: Duplicate the slice properties from the
current program, allowing other programs to load the
slice by selecting the program.

Image Brightness Adjust the brightness of the output image in the
program. The value range is -100 to 100, with a default
value of 0.

Contrast Adjust the contrast of the output image in the program.
The value range is -100 to 100, and the default value is
0.
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Area

Function

Explanation

Insert Program Before

Insert a program before the current program.

Insert Program After

Insert another program after the current program.

Delete Program

Delete the currently selected program.

4.7.6 Cross Program Continuation

When the same media needs to be played at the same layer position for multiple consecutive

programs, adding the same media to each program individually will cause the media file to start

over upon switching programs. By using this feature, this issue can be perfectly resolved,

allowing the contin ued media to play normally without restarting when switching programs.

Step 1 In the program management area, right click the media that needs to be continued, and select

Cross Program Continuation

Figure 4-34 Cross program continuation

Program  Timeline

. Play
Stop

ross Program Continuation

Rename

E Enable Media Keep
- Copy Ctrl+C

&
FiEE Cut Ctrl+X

Playback
~ Copy Properties

Live
Locate Media
Access File Location

Delete Media

Step 2 Click and hold the left mouse button on the media, then slide left or right to the target program

where you want to continue.

B Note

After completing the media cross program continuation setup, right click the media across

programs and select Cancel Continuation to remove the continu ation setup.
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4.7.7 Program Context Menu

Right click the program to display the program context menu.

Figure 4-35 Program context menu
Program  Timeline
> P1 play

* # Stop

Pin Program

Layer1
uhi]
=l Apply to All

Layer2 . & Enable Program Keep

D G| Lock Slice Layout

E BEHEINE

& (4
E '.'4 Cut Ctrl+X

Copy Ctrl+C
Playback

: Insert Program Before
Live =
Insert Program After
Delete Program

~ Clear Media

Play: Play the current program.

Stop: Stop the program playback, and when played again, the media in the program will

start f rom the beginning.

Pin Program: Place the selected program on the left most of the program list. The pinned

program always remains displayed on the left side of the program list.
Cancel Pin to Top: Remove the current pinned program.
Apply to All: Apply the configured properties of the current program to other programs.

Enable Program Keep: After enabled, when switching back to the program, the program will

continue playing from where it left off.

Disable Program Keep: After disabled, when switching to this  program, the program plays

again from the beginning.

Lock Slice Layout: Lock the current program's slice layout. Once locked, the slices in the

editing area cannot be moved.
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Unlock Slice Layout: Unlock the slice layout in the current program, allowing the  slice in the
editing area to be freely moved once unlocked.

Insert Current Program: Immediately play the current selected program and automatically
pause the program that is currently playing. Once the interrupted program finishes, the
paused program will automatically resume.

T In the pre - edit mode, this function is not supported.
T This function is not supported during media collection playback.
T This function is not supported during cross program continuation playback.

T When multiple insertions are made, after the interrupted program finishes, it resumes
playing from the program just before the last insertion, rather than returning to the
program before the first insertion.

T After the insertion, the program will display the currently playing content and the
prog ram name area of the interrupted program will be marked with a different color.

Rename: Change the name of the program.

Cut: Cut the currently selected program, including media from all layers within the program.
Shortcut key: Ctrl +X.

Copy: Copy the curren tly selected program, including media from all layers within the
program. Shortcut key: Ctrl +C.

Paste: Paste the copied or cut content into the selected program. Shortcut key:  Ctrl +V.
Insert Program Before: Insert a program on the left side of this  program.

Insert Program After: Insert a program on the right side of this program.

Delete Program: Delete the currently selected program.

Clear Media: Clear all media in the selected program.

4.8 Edit Timeline Layers

4.8.1 Add Timeline Media

Step 1 Click Timeline to enter the timeline media management interface.

Step 2 Select the target media file in the media library, click and hold the left mouse button, then drag

it to the media area below the timeline to add the layer and media to the timeline.
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Figure 4-36 Add timeline media

ORCECRORORONG
CUE ABC CUE 113"
T
) [

The timeline will show the current media start time. Drag leftward or rightward to quickly adjust
the media playback start time.

4.8.2 Edit Control Commands

Add Control Commands

Adding control commands allows timeline positions to trigger playback control com  mand.

After adding timeline media, right click the timeline layer and select ~ Add Control Command to
open the control command interface.

Figure 4-37 Add control command

Control Command

Timeline Position  00:03:27:000

Execute Action Jump to Next Clip

OK Cancel

Timeline Position: Set the specific time point on the timeline for the command trigger

Execute Action: When reaching the trigger point, initiate the next playback control. Options
include Jump to Next Clip , Jump to Specific Clip , Jump to Specific Time , Pause Playback ,
Loop Playback , and Play from Start .

Modify Control Commands

After adding a control command, a shortcut icon appears on the timeline layer. Different actions
show different icons. Right click the shortcut icon and select Edit to open the control command

editing interface.
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Modify command details and click OK to compl ete the changes.

Delete Control Commands

Delete single command: Right click the shortcut icon and select Delete to delete the selected

control command.
Clear all commands:

1 Press and hold Ctrl, and select the shortcut icons on the timeline layer to select multiple

command. Right click and select Delete to delete them.

T Right click a shortcut icon on the timeline layer and select Clear All Commands to clear

all commands.

4.8.3 Configure Timeline Proper ties

Step 1 Click Timeline to enter the timeline interface.
Step 2 Right click the timeline and select Timeline Properties to enter the timeline properties interface.

Figure 4-38 Timeline properties

v Timeline

Time Position ¢

Total Duration

Time Position: Set the start position for the first play in the timel ine.

Total Duration: Set the overall length of the timeline.

) : Reset the time value to default.

4.8.4 Configure Timeline Media Properties

Step 1 Inthe Timeline area, select the media.

Step 2 Inthe Properties area on the right pane, configure the timeline media properties.
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Basic

Figure 4-39 Media properties - basic

v Basic

Name 1

Duration  00:00:08:976

Playback

Start Time

End Time

Time Position 00:00:00:000

Playback

Name: View or modify the media name.
Duration: View the media duration.
Playback: Set the playback duration for this media.

T If the playback duration is longer than the media duration, the media will automaticall vy

replay.

T If the playback duration is shorter than the media duration, the media will play for the

set duration, and any unplayed content will not be shown.

Start Time: Set the start time for media playback. The start time value cannot be greater

than the media duration value.

End Time: Set the end time for media playback. The end time value must be greater than the

start time value and cannot be greater than the media duration value.

Time Position: Set the start playback time for the media on the timeline.

Click O next to each parameter to reset the value to default.

Figure 4-40 Media properties - playback

Transition Cut

Volume

Transition: Set the transition effect for switching media in the timeline layer. Currently only

supports Cut.

. . . ) .
Volume: Adjust the output volume of the media. Click D to mute the media.
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Graphics Card Mapping

Image

Figure 4-41 Media properties - GPU mapping

v GPU Mapping

Device Local
In Use None

GPU Auto Select

Device: The media is output from this device.
In Use: View the graphics card currently used by the media.
GPU: Setthe graphics card for rendering the selected media.

Check Auto Select for the system to choose automatically, or uncheck to manually select a

graphics card. Click Apply to complete the graphics card switching.

Figure 4-42 Media properties - image

v Image

Fip OH OV

Rl Fill @

Accurate Seek ®

3 stretch ®

Flip: Configure the media image flipping.

Uncheck the checkboxes for H and V and the output image will be displayed normally

without flipping.

T H: Flip the output image horizontally.

T V: Flip the output image vertically.

Fill: Select the way how the content o f a layer is displayed.

T Fill: The media image fills the entire layer.

1 Proportional: The layer image is scaled proportionally and displayed within the layer.

Accurate Seek: By enabling the function, users can quickly jump to a specific timestamp in a

video or audio file without manually dragging the progress bar to search.

Y/C Stretch: When enabled, the bright areas of the output image become brighter, and the

dark areas become darker. It is turned off by default.
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Color

Crop

Figure 4-43 Media properties - color

v Color

Contrast

Opacity

Hue

Saturation

Brightness: Adjust the overall brightness of the layer image. The value range is -100 to 100,

with a default value of 0.

Contrast: Adjust the overall contrast of the layer image. The range of valuesis -100 to 100,

with a default value of 0.

Opacity: Adju st the opacity of the layer image, with 0% being completely transparent and

100% being opaque. The default value is 100%.

Hue: Adjust the color offset of the layer image. The range of values is -100 to 100, with a

default value of 0.

Saturation: Adjusts the vividness of colors of the layer image. The value range is -100 to 100,

with a default value of 0.

Click o)

next to each parameter to reset the value to default.

Figure 4-44 Media properties - crop

v Crop

Mode: Select the cropping method.
T Stretch: Scale up or down the output image.
T Crop: Crop the output image.

T Proportional: Scale down the output image proportionally.
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Borders

Crop By: Set the parameter unit for cropping.

T Proportional: The proportion of the image cropped from the entire image
T Pixel: The pixel dimensions for cropping the image

T: Set the size of the area at the top of the media image that is cropped.

B: Set the size of the area at the bottom of the media image that is cropped.
L: Set the size of the area at the left of the media image that is croppe d.

R: Set the size of the area at the right of the media image that is cropped.

Figure 4-45 Media properties - borders

v Borders

Color @ R

Unit P rtional O Pixel

Width O

Color: Configure the border color of the media.

Toggle the switch to activate the border function for the media.
Set the border color using the following four methods.

T Click the color picker tool and click to select the desired color.
T Click the color block and select a color in the pop -up box.

T Enter the color code value after the # symbol.

T Double click the values next the RGB values and enter the value for each RGB
component to precisely specify the color.

T Modify the value nextto A to adjust the opacity of the borders.
100 is fully opaque, and 0 is completely transparent.

Unit: Set the size unit of the border.

T Proportional: The border size as a percentage of the media size

T Pixel: The border size in pixels

Width: Set the width of the borders.

T Proportional: Adjust the border width by setting the border size as a percentage of the

media size, ranging from 0% to 100%.
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1 Pixel: Adjust the border by specifying how many pixels it occupies to set the border

width, ranging from Opx to half the minimum of either the width or height of the media.

Keying

Figure 4-46 Media properties - keying

Matte Strength

Shadow Adjust ©

Color: Key out the specified color from the selecte d media.
Toggle the switch to activate the keying function for the media.
There are four methods for specifying the keying color.

T Click the color picker tool and click to select the desired color.
T Click the color block and select a color in the pop -up box.

T Enter the color code value after the # symbol.

T Double click the values next the RGB values and enter the value for each RGB

component to precisely specify the color.

Matte Strength: The higher this value, the stronger the keying range/color correction. Wh  en
you need to accurately key out a color in an image, it is recommended that this value is set

to smaller than 10%; in other cases, more than 50% is recommended.

Shadow Adjust: The higher this value, the cleaner the noise areas in the shadow of the

foregr ound are keyed out.

4.9 Edit Timeline

4.9.1 Edit Clips

Split Clips
Kompass FX3 Pro supports splitting the timeline for playback, with individual clip looping
supported.

Step 1 Place the mouse on the timeline, right click to select the start point, and choose  Split Clip to set

the clip start time.
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Step 2 Right click to select the end point, choose Split Clip to set the end time.

Step 3 Repeat the above steps to split additional clips.
Merge Clips

Merge adjacent clips.

Merge Forward: Right click the clip, and select Merge Forward to combine it with the

previous clip.

Merge Backward: Right click the segment, select Merge Backward to combine it with the

next clip.

Lock Clips

Lock split clips. The clips cannot be merged after locked.

Right click the clip, select Lock to lock the clip .

4.9.2 Add Cue Tags

Kompass FX3 Pro allows adding Cue tags on the timeline for visualizing specific points or

events, aiding in navigation and timing control.
Step 1 Right click the timeline and select Add Cue Tag to enter the tag addition interface.

Figure 4-47 Add Cue tags

Add Cue Tag

Time 00:04:19:000]

Marker

Comment

Cancel

Step 2 Enter the start time for the tag in the  Time field, configuring the Cue tag position. By default,

the timeline time at the mouse - click position is displayed by default.
Step 3 Enter the tag name in the Marker field. The name can contain 1 to 10 characte rs.

Step 4 Enter the comments in the Comment field. The comment support 1 to 50 characters.
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E Note

After adding a Cue tag, it appears on the timeline. Right click the tag and select  Edit or
Delete as needed.

Press and hold the Alt key to move the tag left or right. Ch anges will sync automatically to
the Cue table.

The Cue table displays the tag type, marker, and comment in real time.

If the timeline is locked, tags cannot be deleted or moved.

4.9.3 Configure Cue Tables

Import and export tag configuration tables.
Import Cue Tables

Step 1 Right click the timeline, and select Configure Cue Table to access the Cue table interface.

Figure 4- 48 Configure Cue tables

Cue Table

Import Export Time left: 02:00:00.000 M

No Tag Type Marker Comment

1 CUE ABC

2 CUE 111

Step 2 Click Import , choose a pre- existing configuration file (.txt), and click Open to import.
Export Cue Tables
In the Cue table interface, click Export , select the storage path and file (.txt), and Save.

Switch Cue Tags

&

provides real - time feedback, such as the remaining time.

In the Cue table interface, click to switch playback between Cue tags. The Cue table
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E Note

Only one Cue table can be active per project file.

Only one Cue table can be imported or exported at a time.

4.9.4 Configure Offset Time

Step 1

Step 2

Step 3

Step 4

Step 5

Time offset allows adjusting a media's starting position on the timeline by specifying a time

value and offset direction (lef t/right). This operation provides accurate control over media

placement by increasing or decreasing the defined offset time.
Right click the timeline, and select Offset Time .
Figure 4-49 Configure offset time

Time Offset

Cursor Pos 4 02:00:00:000

Offset Direction Backward © Forward

Offset Time <« 00:00:000

Cancel 0K

Set the specific time in Cursor Position .
Select Backward or Forward in the Offset Direction section.

Backward: Media to the right of the cursor position moves to the right.

Forward: Media to the left of the cursor position moves to the left.
Set the offset time.

Click OK to apply the offset time set tings.

4.9.5 Configure Clip Properties

Right click a clip, and select Clip Properties to view properties on the right.
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Figure 4-50 Configure clip properties

~ Basic

Name Clip3

Duration  01:57:14:000
Start Time <« 00:02:46:000 »

End Time

Name: Enter or change the clip name.

Duration: View the clip duration time. The value updates automatically when the start time or

end time of the clip is modified.
Start Time: The start time of the clip

End Time: The end time of the clip

E Note

On the timeline, you can also drag the left or right ends of a clip to adjust its start time and end

time.

4.9.6 Configure Timcode

The Kompass FX3 Pro supports external timecode for controlling timeline media playback, with
LCT and MTC timecodes available.

Navigate to Window > Timecode to open the timecode configuration interface.

Figure 4-51 Configure timecode

Timecode

Type O None LTC

Device Microphone (Re

Offset  Oms

v

Follow O Timeline
Format: 00:00:00:00 represents HH:MM:SS:FF, meaning Hours: Minutes: Seconds: Frames.

Type: Configure the timecode type, supporting LTC and MTC.

Device: Choose the device in the system for playback control. After selection, the frame rate

of the timecode wi Il be automatically read.

Offset: Set the timecode offset in milliseconds (ms).
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Follow: Enable or disable the follow function between the timecode and timeline.

1 When enabled, playback controls on the timeline are disabled, and the system

automatically foll ows the timecode time for playback.

1 When disabled, playback and control via the timeline are possible.

4.10 Configure Effects

4.10.1 Add Effects

Click Effects Library on the right to open the effects interface. Drag an effect onto the media in
slices, programs, or the timeline to add the effect. You can modify the effects in

Properties >Effects

Figure 4-52 Add effects

Hovering the mouse over an effect icon will animate the effect. Once dragged onto the media in

the program or slice media, an effect icon appearP 8§Z TFL ONNLO O8SG6FT 1 bOZ

E Note

Audio media and native - mode webpage media do not support the addition of effects.

4.10.2 Configure Effect Properties

After adding effects, click the media with effects inthe  Program area. In Properties > Effects,
youcansetand Zb k8§ O7 KLTESyLk LOOLI T NEOEZLTLOP

Uncheck the box before the effect name to stop showing the effect.

Click -Iir next to the effect's name to delete the effect.
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Click )

next to the effect name to reset all effect parameters to their default values.
Fisheye

The fisheye distortion effect allows the display to mimic the ultra -wide-angle, edge - distorted

visuals of a fisheye lens, suitable for spherical screens.

Figure 4-53 Fisheye effect

¥ Effects

= Fisheye

Center X

Center Y

Radius

Distortion

Center X: Adjusts the horizontal center position of the fisheye effect  on the selected media
for precise effect placement.

The value range is 0% to 100%, and it defaults to 50%.
Center Y: Adjusts the vertical center position for precise effect placement.
The value range is 0% to 100%, and it defaults to 50%.

Radius: Control the fisheye effect's area size, with a default value of 20%, meaning the effect
impacts 20% of the object's width and height.

The value range is 0% to 50%, with 0% indicating no effect and 50% indicating it covers half
the width or height.

Distortion: This calculates the embossing effect for the fisheye special effect, controlling its
strength and visual impact. By adjusting this parameter, the fisheye effect can manifest
varying degrees of concavity or convexity, enhancing the image's three - dimensionality and
visual appeal.

The value range is 0.00 to 5.00, and it defaults to 3.00. The larger the value, the more

pronounced the concavity and convexity.

Strobe

This create a flickering effect through rapid on -and- off imagery, designed to capture attention

and create a dynamic atmosphere.
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Figure 4-54 Strobe effect

v Effects
@ Strobe

Color Z# [ #Frerer

Red
Green
B e——
Freq/min (o}
Duration

Gradient

Color: Set the strobe color.

T / : Click the eyedropper to select the desired color.

T Click the default white color block to open the color picker and choose a color.

T Enter a hexadecimal color code in the text box to set a precise color.

T Set the color by adjusting the RGB values in the text box.

Freg/min: Configure how many times the strobe occurs per second.

The higher the value, the faster the strobe. The value range is 1 to 100, and it defaults to 10
Duration: Determine how long the opacity change lasts for the strobe color.

The value range is 0 to 100, and it defaults to 50%.

Gradient: Set the proportion of time that the color fades in and out during the duration.

The value range is 0 to 100, and it defaults to 50%.

Jitter

Jitter is a visual effect that adds a dynamic feel to the image through slight or rapid vibration,

enhancing vitality and realism.

Figure 4-55 Jitter effect

v Effects

~ Jitter

Freg/min

X Offest

Y Offest
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Scroll

Step 1

Step 2

Step 3

Mask

Freg/min: Set the default speed of movement per unit time.
The value range is 1 to 200, and it defaults to 100.
X Offset: Set the horizontal displacement for the jitter based on the original media width.

The value range is 0 to 100, and it defaults to 20%, meaning a single displacement value is

20% of the media's original wi dth or height.
Y Offset: Set the vertical displacement for the jitter based on the original media width.

The value range is 0 to 100, and it defaults to 20%, meaning a single displacement value is

20% of the media's original width or height.

During playback, media scrolls according to the configured direction, and the scrolling speed is

adjustable.
Select the media layer in the program that you wish to configure for scrolling playback.

In Direction , set the media scrolling direction. The options incl ude Left to Right , Rightto Left ,

Top to Bottom , and Bottom to Top .
In Speed PLT TilL ZLKkSE PI1 Obyyszs6 PNLLK EFL lJEyoL

Scrolling speed can be adjusted by dragging the slider left or right, or by entering a specific

number in the textbox on the right.

A layer mask uses a specific shape (such as a heart, triangle, oval, or rectangle) to obscure parts
of the image, displaying only the content within the mask shape, creating a uniquely

personalized visual e ffect.
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Figure 4-56 Mask effect
~ [Effects

= Mask

Shape W Heart O Invert

Center X
Center ¥
Width

Height

Shape: Choose the mask shape. The options include Heart , Circle (Ellipse) , Triangle , and

Custom Image .
If you check Invert , the image outside the shape is displayed, while the inside is not.

When the mask shape is set to Custom Image , click Upload to manually choose a custom

mask image.

Center X: Set the X coordinate for the center of the mask's bounding rectangle based on the

original media width.

The value range is 0 to 100, and it defaults to 50, meaning 50% of the medi a's original width

or height.

Center Y: Set the Y coordinate for the center of the mask's bounding rectangle Based on the

original media width.

The value range is 0 to 100, and it defaults to 50, meaning 50% of the media's original width

or height.
Width: Set the width of the mask's bounding rectangle.

Height: Set the height of the mask’s bounding rectangle.
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Border

Figure 4-57 Border effect
v Effects

2 Borders

Greos Qe —

B e O—

Opacity

Unit By Percentage (1 By Pixels

Width o

Color: Configure the media's border color.

Enabling the checkbox activates the border. You can set the border colo rin four ways:

i Click the color pick tool nextto Color EZk PLyL1 T TiL kKLPSOLk 1bybO

T Click the color block nextto Color, and choose a color fromthepop -ON 1 bybO PLylLI1 T
T Enter a hexadecimal color code nextto #.

T Enter values for the Red, Green, and Blue components to precisely set the color.

¢CNEI §TT KOOPT TFL I BOkLO P BNEI §TI §P OO0y
Unit: Set the size unit for the border.

i ;7 WLOILZTEGSL :BOKLO PslL EP E NLOILZTEGSL BO

T By Pixels: Border size in pixels.

Width: Adjust the border's width.
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Keying

Figure 4-58 Keying effect

v Effects

@ Keying

Key Color Z

Red (mmm——
Green O—
B Ue O—
Strength

Shadow ©

Key Color: Remove a specific color from the selected media.
Enabling the checkbox activates the keying function to remove the selected color.

The selection methods include:

i Click the color pick tool 7 Th PLyL1 T TFL OZNEZTLK 1BybO BZ T
i <ysi1 4G TFL 1Bbybo iybr & EZk 1FbBPL E 1ByboO

T Enter the hex code of the color to be removed nextto  #.

T Input specific values for the Red, Blue, or Green components for p recise color setting.

Strength: Higher values increase the range and correction strength. For precise color keying,

use an intensity below 10%. In other cases, above 50% is recommended.

Shadow: Higher values clean noise areas in shadows more effectively.

Other Settings

Enable or disable effects
Check or uncheck the box to enable or disable the added effect.

Delete effects

Click 0]

next to the effect's name to delete the effect.

Restore defaults

i Click o

next to the effect name to reset all effect parameterst o their default values.
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Click 9

next to a single effect parameter to reset it to the default value.

4.11 Edit Output Slices

The output of Kompass FX3 Pro is in the form of slices, with the slice replicating the

corresponding layer image for output.

In the stage editing area, select the slice, and then you can make adjustments to it. Drag the
slice to different outputs to adjust its output position.

Figure 4-59 Slices

Editing Area (Live)

T
Outputlel

Outputl-4
1920x1080

The top left corner number, such as 1, 2, or 3, indicating that this slice is a layer slice in the

program.

The top left corner identifier T+number , such as T1, T2, indicating that this slice is a layer
slice in the timeline.

The bottom left corner number, such as G1 or G2, indicating that this slice is bound to the
layer. If the graphics card number is not displayed, it means the slice is not bound to the
layer.

Adjust the slice size: Hover the mouse over the slice edges, hold the left mouse button and
drag to resize the slice.

ra
When the slice is within an output, click ¥ < in the bottom right corner or double click the

slice, and the slice will fill the entire output connector.

rAa
When the slice crosses multiple output connectors, click ¥ < in the bottom right corner,

and the slice will fill the output connectors it crosses.

When you select a slice, click @ in the bottom right corner to capture the current

playback image and save the captured image into the media library.
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Right click the slice to access the following options:

Context Menu Menu Item Description

Rectangle Slice Rectangle Slice Add a rectangular slice. Please refer to Add
Slices for instructions.

Polygon Slice

. Polygon Slice Add a polygon slice. Please refer to Add Slices
Delete Media . .
for instructions.
Lock Slice
Delete Media Delete the media on the current slice.
Delete Slice
_ __ Lock Slice Lock the selected slice.
Clear All Slices
e T Delete Slice Delete the selected slice.
Clear All Media
Clear All Slices Remove all slices from the editing area.
Clear All Media Clear the media from all slices.

4.11.1 Add Slices

E Note

The slices can be added to the timeline automatically only, but cannot be manually added or
removed.

The slices added to the timeline will automatically bind to the timeline layer, and modifying
the binding between the slices and the timeline layer is not supported.

If all media in a timeline layer are deleted, the current timeline layer will be automatically

removed, and the corresponding ti meline layer slice will also be automatically deleted.

Add Rectangular Slices

Each time a layer is added, an output slice is automatically added. When a layer needs to be
displayed on multiple output screens and the output needs to be synchronized, multip  le output
slices can be used for output.

Step 1 In the stage editing area, right click the blank area and select Rectangle Slice to add a slice.
Step 2 Select the newly added slice.
Step 3 Select Properties on the right to enter the slice properties interface.

Step 4 Select the layer for the slice from the drop -down menu nextto Bind Input .
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Add Polygon Slices

The editing area supports adding polygon slices, including triangular and trapezoidal slices, with

a default size of 1920x1080. It also supports custom shapes usi ng the mouse.
Step 1 In the stage editing area, right click the blank area and select Polygon Slice .

Select the triangle or trapezoid nextto Polygon Slice to directly add a polygon slice.

Click Polygon Slice and the cursor will change to Eﬁ’ You can customize anchor points by

clicking in the editing area, with a minimum of 3 anchor points.

Step 2 After drawing a polygon, double click the left mouse button or press Enter to finish. The
polygon will automatically close and display a bounding rectangle, with the slice numbe  r shown

in the top - left corner.

E Note

Polygon slice drawing can be canceled by pressing the Esc key.

Polygon slices support advanced editing, and advanced editing automatically exits when the
mouse clicks the layer or non - editing area.

During the advanced edit ing, double click the anchor line to add anchor points and press the
Delete key to remove anchor points.

During the advanced editing, press and hold the Ctrl key to select multiple anchor points,

and drag the mouse to edit multiple anchors simultaneously.

4.11.2 Slice Properties

Select a slice and make precise adjustments in the Properties area on the right pane.
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Figure 4-60 Slice properties

~ Basic
Name
Bind Input
on X 1
S W 1919
Slice Ratio O 01610 OG54
Rotate

Flip O Horizontal O Vertical

Priority §8 1 MoveUp < Move Down +Top < Bottom

~ Color
Opacity
Red oo—)
A —— O R
be co— ()
v Advanced
Anchor Edit @
Live Update
Adjustment
Position
Anchor
Anchor Co...
Line Color
Anchor Step
Guideline

Grid Lines

Table 4-5 Slice properties

reference point.

Area Function
Basic Slice name View and modify the slice name.
Bind input Select the input source for the slice. The input sources
only include the layer media in the current program.
Position Set the position of the output slice on the current

screen using the top - left corner of the screen as the

X: The horizontal distance from the top - left corner of

the slice to the top -left corner of the screen output

Y: The vertical distance from the top -left corner of

the slice to the top -left corner of the screen output
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Area

Function

Description

Size

Set the slice size.
. W: The horizontal width of the slice

. H: The vertical height of the slice

Slice ratio

Quickly adjust the aspect ratio of the slice. The options
include 16:9, 16:10, 5:4, and 4:3.

Rotate

Rotate the slice clockwise, using the center point of the

slice as the reference for rotation.

Flip

Flip the output slice image. The options include
Horizontal and Vertical .

. Horizontal: The slice image is flipped horizontally.
. Vertical: The slice image is flipped vertically.

. If neither option is selected, the slice image is
displayed without flipping, playing normally.

Priority

View and adjust the slice priority.

. View: Display the slice priority using a number. The
larger the number, the higher the priority. Slices with
higher priority are displayed first.

. Adjustment: Clic k the arrow icons to adjust the slice
priority.

Color

Opacity

Adjust the opacity of the output image. 0% is fully
transparent, 100% is opaque, and the default value is
100%.

Red

Adjust the output image quality by modifying the red

color.

Green

Adjust the output image quality by modifying the green

color.

Blue

Adjust the output image quality by modifying the blue

color.

Advanced

Anchor edit

Enable or disable the anchor point editing function.

Live update

Enable or disable the live update feature.

E Note

Only when Anchor edit is enabled, this function can be

turned on or off.
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Area

Function

Description

Adjustment

Set the adjustment mode of the polygon slice. The
options include Flat and Linear.

Position

Set the coordinates of the currently selected anchor
point, with X representing the horizontal coordinate
and Y representing the vertical coordinate, and support

four adjustment methods.

. Select and drag the anchor point with the mouse. X,

Y values change in real time.

. Select the anchor point, and press the arrow keys on
the keyboard. X, Y values change in real time, with
stepping value consistent with the vertex stepping.

. Select the anchor point, double click the values in the
X, Y sections to manually input the coordinates,
ranging from -65535 to 65535.

ol
. Select the anchor point, click “ nextto X, Y to
adjust the coordinates, with stepping value consistent
with the vertex stepping.

Anchor

Enable or disable the on screen display function of
anchors. Set whether the anchor point editing process
is simultan eously displayed on the output screen.

Anchor count

Split the connector screen horizontally and vertically,
and after splitting, you can edit the anchor points in

each direction respectively.

Line color

Set the color of the lines between the anchor poi nts.

The default color is . and the color switching takes

effect in real time.

Anchor step

Adjust its position using the arrow keys on the
keyboard. Each keystroke moves the anchor point a
distance ranging from 1 to 10, with a default value of
10.

Guideline

Enable or disable the guideline between the anchor
point and its adjacent anchor points.

. Set the line color using the following methods.

i Click the color block and select a color from the
pop - up window.
i Enter the color code value in the text box n ext to

the color block.
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Area Function Description

. Set the line width. The value range is 1 to 10 and with
a default value of 1. One - click reset to default value is
supported.

Grid lines Display the grid lines on the slice. The options include

Canvas Display and Screen Display .

4.12 Play Programs

Once the program editing is completed, you can play the programs.

Control the program playback

T Click ’ on the program name to start playing.

T After the program is being played, click to pause the program, and ’ will show

when the program is paused.

T Click ’ to resume playback from the paused position.

During the program playback, it is possible to switch the content of the layers being played.
For example, while program 1 is being played, you can switch the conte nt of the layer by

double clicking the media in Program 2 > Layer 2, as shown below.

Figure 4-61 Control program playback

Program  Timeline

+ P (5/50) 23 4 6 8 9 » P10 > P11 » P12

Layer1
© B G

Layer2
e D 6

0
e E =

@ D & 1

| Ay ]

In the playback control area, you can control the playback of individual media or the entire

set.

Figure 4-62 Control media playback

Playback

v 8 10.41.90.43 (16005558-1)

ive Pre-Edil | || ape

1 Click l’ or “ on the left to play or pause all media in the program.

1 Click ﬂ on the left to stop all media playback in the current program.

www.novastar.tech 107



NOVASTAR Kompass FX3 Pro Multimedia Playback Software

Advanced Edition User Manual

1 Click ’ or I I before each media name to play or pause the selected media
playback.

T Click @ in the top right corner, and the program media timer will display the

playback in forward timing.

T Click in the top right to display the program media timer countdown playback.

—
T Click ¥ inthe top right corner, select the programs you need to synchronize,  drag

the media progress bar, and complete the synchronized playback of the media.

Control the timeline playback.

Figure 4-63 Control timeline playback

T @: Click to stop timeline playback, and once stopped, the timeline position will

automatically move to the start position on the far left.

T @: Click to start timeline playback. Once the timeline is playing, @ will be

displayed, and you can click to pause playback.

T @: Click to replay from the beginning of the timeline.

Turn pages.

When media files such as PowerPoint slides are added to the program, you can control
playback using keyboard arrow keys. Click on the menu bar to enable keyboard page -

turning playback; once enabled, the icon changes to

. <> . . . .
Click on the menu bar to view key prompt information for  page-turning.
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Figure 4-64 Page turning

Page

PowerPoint support the page turning function. The turning methods include:

I. Laser pointer

use the keyboard up/down/left/
right arrow k

Pgup

413 Configure Scheduled Playbacks

After the program editing, you can realize automatic playback of the programs according to the

scheduled time and times.

Step 1 Navigate to > Edit Scheduled Playback to open the scheduled playback interface.

Figure 4-65 Scheduled playbacks

Scheduled Playback

Cancel Enable OK

Step 2 Click New Task at the top right of the window to create a new playback task.

www.novastar.tech 109



NOVASTAR Kompass FX3 Pro Multimedia Playback Software

Advanced Edition User Manual

Figure 4-66 Playback tasks

Scheduled Playback

New Task

B W

Step 3 Set the start date and end date of the task in the  Effective area.

Step 4 Click + next to the effective time to add a new playback task.

Figure 4-67 Configure scheduled programs

Select Programs

Program List Plan List T & Delete

] Nao. Program List Count

O P

Total scheduled duration:00:00:05.000

Cancel | OK

1. Select the desired programs in the Program List area on the left.

2. Click »

to add the selected programs to Plan List.

The programs will be played according t o the sequence (from the top to the bottom) in the

Plan List area. If you want to adjust the playback sequence, check the box next to the
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desired program and click /I\ or ‘l’ to adjust the sequence of the selected program.

Only one program sequence can be adju sted at a time.
3. Double click the play count on the right side of the program to set the playback count.

After the setting, the software will automatically rearrange the program playback order
according to the set count to minimize consecutive playbacks of the same program.

The play count range is 1 to 999.

If a program play count exceeds 1, the system will first play programs in order. After
completion, for programs with a play count greater than 1, the system will automatically loop
through the list until the set play count is reached.

After the setting, the system will automatically calculate the total duration of the planned
programs. If the total duration exceeds 24 hours, program configuration cannot be
completed.

4. Click OK to complete the settings.
Step 5 Click OK to return to the scheduled playback interface.

Figure 4-68 Configure playback tasks

Scheduled Playback

New Task

~ Taskl B
Ef s From 2025.03.17 2 to 2025.03.17 2

Plan1: P1P2 I Mode Countv From 00:00:00 Z to 00:00:10 Count 1 J Date Every day ~ Stop FTB

PlanZ: P1,P2P3 I Mode Count~ From 00:00:10 [ to 00:00:225  Count 1 . Date Every day ~ Stop FTB

Cancel Enable oK

Step 6 Select the program playback mode nextto Mode . The options include Time and Count.

Time: The programs will be played by the set duration circularly.

Count: The progr ams will be played according to the set playback count.

Step 7 Set the start and end time within the schedule range.
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Step 8

Step 9

1. Setthe automatic start time of the program inthe  From section.
2. Set the automatic end time of the program in the  to section.

When the playback mode is setto Count, the end time of the program playback is
determined by the start time plus the total duration of the current scheduled program. This

end time cannot be modified.
Set the program playback count.

Click the number next t o Count to activate the function. Enter the desired value and then the
program will be played automatically according to the set count. When the playback mode is

set to Time, the playback count of the program is 1 by default and cannot be changed.

Set the program playback date. The options include Every day , Monday , Tuesday, Wednesday ,
Thursday , Friday , Saturday and Sunday .

Every day: The plan will be played every day automatically according to the schedule within

the effective time range.

Monday to Sunday: The plan will be active on the selected days of the week within the
specified time range, and the content will be automatically played according to the

configured schedule and playback plan.

Step 10 Set the action after the program stops. The options incl ude FTB and Current Frame .

FTB: After the program playback ends or the playback time reaches the end, the output

image fades to black.

Current Frame: FTB: After the program playback ends or the playback reaches the end time,

the output image displays the f rame when the program stops.

Step 11 Repeat Step 4 to Step 10 to add more plans under the current task.

Step 12 Repeat Step 2 to Step 10 to add more tasks and plans.

Step 13 Click OK to finalize the program scheduling.

Click Enable to activate the current program schedule. Once the program schedule is enabled,

the scheduled playback icon on the menu bar changes to

Step 14 Navigate to > Enable Scheduled Playback to enable the function.

E Note

Different plans cannot have the overlapping time slots.

Different tasks cannot have the overlapping time slots.
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Insert Programs

Once the scheduled playback is activated, it supports the program insertion. This insertion can

be executed either immediately or with a delay.
Immediate Insert: Play the next selected program instantly.

Delayed Insert: Wait for the current program to finish before playing the selected program.

Step 1 Navigate to > Edit Scheduled Playback to enter the scheduled playback interface.

Figure 4-69 Edit scheduled playbacks
Scheduled Playback
New Task
B o
rom 2025.03.

P1,P2 I Mode unt ¥ From 00:00:00 [ to 00:00:10 J Count 1 [ Date Everyday

~

P1P2P3 } Mode Count~ From 00:00:10 J to 00:00:225 o Count 1 I Date Every day

Cancel Enable oK

Step 2 Click the program name next to the plan that requires insertion to open the program selection

window.
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Figure 4-70 Select programs

Select Programs (]

Plan List * L | Delete

m List Count

Total scheduled duration:00:00:10.000

Step 3 Right click the desired program name in  Plan List and select either Immediate Insert or Delay

Insert to proceed with the program insertion.

Figure 4-71 Insert programs

Scheduled Playback

New Task

Select Programs o X B T

From 120 20, Program List Plan List T Delete

o
P1p2
P1P2P3
Immediate Insert
Delay Insert
Up

Down

Total scheduled duration:00:00:10.000

Enable

Rules for program insertion:

. Only programs that are currently being played or have not  yet begun support program

insertion. The programs that have already been played do not support insertion.
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For a schedule plan that is being played, the insertion can alter the order of the program

sequence.

If an insertion spans different plans, after the insertion, the playback will switch to the plan

that contains the inserted program and continue until the end of the new plan.

If an insertion spans different tasks, after the insertion, the inserted task will play first; once

completed, the playback will revert back to the pre -insertion plan and continue.

More Operations

Delete plans

In the Scheduled Playback interface, click E next to the desired plan to delete the plan.

Delete tasks

In the Scheduled Playback interface, click IE] next to the desired task t o delete the task.
Edit plans

Navigate to > Edit Scheduled Playback . You can add, edit or delete the plans or tasks
in the pop - up.

Create task copies

Click IE] next to the task to create a task copy. By expanding the copied task, you will be
able to modify the related information.

Create plan copies

Click next to the plan to create a plan copy. By expanding the copied plan, you will be
able to modify the relat ed information.

Disable scheduled playbacks

Navigate to > Disable Scheduled Playback to halt the scheduled playback.

4.14 Save Projects

Once the project editing is complete, it can be saved as a separate file for easy access and use

in future projects.

Navigate to File > Save/Save As to save the current project file locally.

+
Click r—l in the top left corner of the main interface to create a new project.
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Click B in the top left corner of the main interface to save the current project file.

Click @ in the to p left corner of the main interface to package the media in use or all

media and project files. The packaged project files can be used directly.
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5 Link

5.1 Link Settings

Application Scenarios

Primary and backup output: When the primary control device encounters  issues or its
connection lines falil, the backup device takes over the role, ensuring uninterrupted work and

preventing anomalies such as a black screen.

Master and slave output: If the master control device cannot independently drive the display,
one or more slave devices can be configured to assist, with unified settings managed by the

master device, ensuring seamless display management.

Figure 5-1 Application scenarios

ET4S-Slave 1 i ET4S-Slave 2 i £T4S-Backup 2
AN

y

.

Ethernet Cable

1, ‘ Sync Signal
Switch | LA B BB Genlock Generator

Ethernet
Cable

Keyboard Mouse ET4S (Local) ET4S-Backup

Prerequisites

The devices (primary and backup, master and slave) must be on the same network segment.

The sync card must be installed in all devices.

www.novastar.tech 117



NOVASTAR Kompass FX3 Pro Multimedia Playback Software

Advanced Edition User Manual

On the master device's Kompass FX3 Pro interface, navigate to Link > Link Management to

access the link settings interface.

Figure 5-2 Link settings

Add Slave Devices

Step 1 Inthe device list, select the IP address of Kompass FX3 Pro device to be used as the slave.

Step 2 Click and drag the selected IP address to the blank area on the right to configure it as a slave

device.
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Figure 5-3 Add slave devices

Once added, the slave device's interface will dis play slave information, and the slave device will

be locked from editing.

Figure 5-4 Slave device interface info

Slave

Local 10.10.101.230 Name: 16004960-P1

Disconnect Master Unlock

Disconnect: Click to disconnect the master and slave devices.

i zyb1 G <ys1 4G THb kSPEIiyL TFiL 1 000OLZT SZTLOOEI L yft

interface. To lock again, navigate to Link > Lock.

Add Backup Devices

Step 1 Inthe device list, select the IP address of Kompass FX3 Pro device to be used as the backup.

Step 2 Click and drag the selected IP address to the blank area on the right to configure it as a backup

device.
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Figure 5-5 Add backup devices

Output Management

Screen Edge Blending

C  Editing Area

Backup
Name 160!
P 10

Slave: Drag a device from Device List to blank area. Backup: Drag a device to ancther device. One device supports one backup only.

Once added, the backup device's interface will display backup information, and the backup
device will be locked from edi ting.

Figure 5-6 Backup device interface info

Backup

Local 10.10.101.230 Name: 16004960-P1

Disconnect Primary Unlock Switch to Primary

Disconnect: Click to disconnect the primary and backup devices.

Izyb1 G <ys1 4 Th kKSPEiyL TiL 1 000LZT S$ZTLOOEI L yt

interface. To lock again, navigate to Link > Lock.

Switch to Primary: Switch the backup device to the primary.

Manage Devices

On the topology, select the slave or backup device. Right click it to open the context menu.
Connect: Manually connect the devices if they are not properly connected.
Disconnect: Manu ally disconnect the devices as needed.
Power On: Remotely start a powered - off slave or backup device.

Ensure that the hardware and network of the media server support and are properly

configured for remote wake -up.
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Power Off: Remotely power off the slave o r backup device.

CLPTEOT ¢LZBTLYy?7 OLPTEOT TilL PyElL BO iEi GON kLI
Restart Application: Remotely restart the software on the slave or backup device.

Retrieve Logs: Obtain running logs of the software from the slave or backup device.

Delete: Remove the binding relationship between the devices.

E Note

To disconnect all linked devices, right click Editing (Local) and select Disconnect All .

5.2 Update to Slave or Backup

On the master device's Kompass FX3 Pro interface, navigate to Link > Update to Slave or
Link > Update to Backup to manually synchronize all data from the master and slave devices or

the primary and backup devices.

At the bottom right of the master device's Kompass FX3 Pro interface, click  Update to view the

update progress.

Figure 5-7 Update progres s

Mowvall

Local: 10.10.101.195 Name: 16006341-P(Master&Editi Slavel Updale@

5.3 Unlock

Locking the local device secures the interfaces of both the slave and backup devices, making

them inoperable.

Slave Device: Navigate to Link > Lock, and the main interface of the slave device will display

the information seen in Figure 5-4.

Backup Device: Navigate to Link > Lock, and the main interface of the backup device will

display the information seen in Figure 5-6.
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6 Settings

6.1 System Settings

Set the status after the system starts. Navigate to Settings > System to enter the system

settings interface.

Figure 6-1 System settings

Startup/Shutdown
Display Auto start, delay
Office 0O Auto restart M y -
0O Shutdown  Daily ~

Communication

Audio
Project File
[ Open recent project on startup
0O Play project after opened  Last time v
O Auto save project every 5 - minutes save, max saves 5 -
Auto save path C ova oc  Browse [Open Available Space 185.5 G | Clear

O No save prompt on close

age area data when creating a new project file

File
Log Storage Permanent ~

Storage Path C VA Browse | Open | Available Space 185.0 G [ Clear

Cache Path C va0013 oc Browse | Open| Available Space 185.0 G | Clear

Undo/Redo

Undo Steps 50

General

6.1.1 General

Startup/Shutdown

. Auto start

T Checked: The software automatically starts after delay when the system boots. Set
delay if USB sound card is added.
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1 Unchecked: The software does not automatically start on boot.

Auto restart: Set a time for the software to automatically restart. If the software runs for an
extended period, it is recommended to schedule a restart to ensure its optima | long-term

performance.

T Checked: The software automatically restarts at set time.
T Unchecked: The software does not automatically restart.
Shutdown: Set the automatic shutdown time.

T Checked: The software shuts down at the set time.

T Unchecked: The software does not automatically shut down.

Project file

Open recent project on startup

T Checked: The software opens the last edited project on start.

T Unchecked: The software shows default interface on start.

Play project after opened

T Checked: The software automatically plays content on opening the project file.
Last: The software plays last closed content.
Program List: The software plays selected content from the list.

T Unchecked: Manual play required after software startup.

Auto save project: Set the save interval and max number of auto -saved project files. The
save interval ranges from 1 to 30 minutes and defaults to 5 minutes. The auto - saved files
range from 1 to 20 and defaults to 5.

T Checked: Enable auto- save at set intervals.

T Unchecked: Disables auto - save.

Auto save path: Set the path for auto -saved projects.
1 Browse: Select the save path.

1 Open: Access the save location.

1 Clear: Clear the save location info.

No save prompt on close

T Checked: The software closes without a save prompt.
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[ Unchecked: The software prompts for save on close.
Reset all outputs when creating a new project

T Checked: Automatically reset the output configuration from the previous project to

default parameters when creating a new project.

[ Unchecked: Automatically use the output conf iguration from the previous project when
creating a new project.

File

Log Storage: Set the storage duration for playback logs. Options include  Permanent , 1
Month , 3 Months , 6 Months , and 12 Months .

Storage Path: Set the storage location for playback logs.

T Click Browse to select a storage location.

T Click Open to open the folder where logs are stored.

T Click Clear to delete all cached playback logs.

Cache Path: Set the storage location for media files downloaded from the master device.

T Click Browse to select a storage location.

Click Open to open the folder where cache files are stored.

] Click Clear to delete cached information.

Undo/Redo

Undo Steps: Set the maximum number of undoable and restorable steps. Exceeding this limit

prevents further undo o r redo actions. This feature requires a restart to take effect.

General

Configure the background and text color information for the stage editing area.

In the Canvas Color section, modify the background color by selecting a preset color or

customizing a co lor.

In the Text Color section, modify the text color by selecting a preset color or customizing a

color.

For custom colors, you can set color information in the following ways:
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1 Use the color picker nextto Canvas Color to select a color from the screen.
T Click the color block to open the color picker and choose a color.
T Enter the hexadecimal color information in the text box on the right.

T Input the color values inthe R, G, and B text boxes to set the color.

Link

Set whether the master device information automatically updates to the slave or backup

devices.

Checked: All configuration information on the master device is automatically synchronized to

the slave and backup devices.

Unchecked: After configuring the master device, the system will not automatical ly
synchronize. Manual synchronization is required via Link > Update to Slave/Update to
Backup .
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6.1.2 Display

Figure 6-2 Display settings
System

General e

Main Window G1{

Office
Display Control
Communication
O Mute FTB
Audio
O MFPS (O EFPS
Fadeln 05s . FadeOut 05s . | ApplytoAll

Layer Qverlay ® Show timeline ontop O Show program on top

Playback

Default Duration PowerPoin

Codec

Main Window: Set the graphics card for rendering the software main interface. After the

configuration, a software restart is required.

Display Control

Mute FTB

1 Checked: Mute all audio when the screen goes black.

1 Unchecked: Audio continues when the screen goes black.
MFPS:

T Checked: The software shows the real -time frame rate at bottom left of preview window

in the stage editing area.
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1 Unchecked: No frame rate display

EFPS:

T Checked: The frame rate is shown at bottom left of output.
1 Unchecked: No frame rate display

Fade In: Set the time length for transitioning between programs, from the start of the
transition to the full display of the program. The default is 0.5 seconds, with a range of 0 to

10 seconds. A value of 0 means a direct cut.

Fade Out: Set the time length during the program transition, from the start of the program
switch to the point where the program is n o longer displayed. The default is 0.5 seconds,

with a range of 0 to 10 seconds, where 0 represents a direct cut.

Apply to all: Clicking this will apply the set fade in and fade out durations to all the programs.
If you set the fade in and fade out duratio ns and do not click Apply to All , it will only affect
programs without added media; programs with added media will not be affected.

Layer Overlay: Set the display order for program layer slices and timeline slices. Changes
take effect after restarting the software.

T Show timeline on top: Timeline slices are displayed over program layer slices.

T Show program on top: Program layer slices are displayed over timeline layer slices.

Playback

Default duration: Set different default playback durations for various med ia.

6.1.3 Office

The software supports the playback of PowerPoint documents, but you need to configure the

basic information of the PowerPoint document before playing it.

In the System interface, click Office to enter the Office settings interface.
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Figure 6-3 Office settings
System
Bamerl PowerPoint Settings

Display a

O Auto play  Interval 00:00:03

. L Playback Animation O Picture
Communication

Resolution W 1920 . H 1080

v v

P Standard
Audio

PowerPoint Settings

Auto play: Set whether the PowerPoint file in the program plays automatically.
Interval: Set the time interval for automatic PowerPoint playback.

Playback: Set the transition method for each slide in the file.

T Animatio n: Display the animations within the slide during playback.

T Picture: Do not display the animations within the slide, but display them during slide

switching.

Resolution: Configure according to the resolution displayed in the PowerPoint document,

supporting individual width and height settings, or setting through preset resolutions.

E Note

After modifying the PowerPoint settings, the changes only apply to newly added files, and
not to those already added to the program.
If the media server has WPS Office, the resolution settings are not supported.
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6.1.4 Communication

The software supports remote control or control through a central control device, allowing
users to play and control the software more conveniently. For the control commands and the
format for writing ¢ ontrol commands via central control or remote control, please refer to the

Control Protocol for Multimedia Playback Software document.
Navigate to Settings > System > Communication to enter the communication interface.

Figure 6-4 Communication
System

General Network
UDP Port 1gg5g ° Close

TCP Port | 49958 ° Close

MIDI

Audio O Enable MIDI

MIDI Device

DMX
O Enable DMX
Node Kompass FX3 Pro
Channel Offset 0 >

Subnet 0

O OSC Input

Input Port

Currently, UDP and TCP/IP protocols are supported for remote control.

Control Through UDP Protocol

Step 1

Step 2

Enter the software UDP port number in the text box nextto  UDP Port.
The range of UDP port numbers is 0 to 65534, with a default value of 18960.

Click Open, and the software will automatically detect if the port number you entered is already
in use.
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Yes => Re enter the port number and click Open again to check.

No => UDP control is enabled successfully.

Control Through TCP/IP Protocol

Step 1

Step 2

MIDI

DMX

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Enter the software TCP port numbe rin the text box nextto TCP Port.
The range of TCP port numbers is 0 to 65534, with a default value of 17613.

Click Open, and the software will automatically detect if the port number you entered is already

in use.

Yes => Re enter the port number and cli ck Open again to check.

No => UDP/IP control is enabled successfully.

Check Enable MIDI to activate MIDI control. Once enabled and connected to the media server,

the system will automatically detect and list MIDI devices.

Navigate to Settings > MIDI Binding to enter the MIDI binding interface and assign functions to
MIDI buttons.

Before controlling via DMX, complete the DMX configuration.

Check Enable DMX to activate DMX control.

Select the node name for DMX control under Node.

Set the offset in Channel Offset .

Configure the subnet information for DMX devices in  Subnet .

Set the domain information in Universe , ensuring it matches the media server's domain.
Click Send to complete the configuration between DMX and the media server.

Navigate to Settin gs > DMX Binding to enter the DMX binding interface and assign functions
to DMX buttons.
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OSC

After enabling OSC input, connect and configure the OSC device.
Step 1 Check OSC Input to activate OSC control.

Step 2 Set the input port to match the port in the touchOSC contr ol software (default 8001).

6.1.5 Audio

Sound card mapping refers to creating a mapping relationship between virtual and physical
sound cards. One virtual sound card (i.e., sound card mapping) can be bound to multiple
physical sound cards, and the same physical sound card can be bound to multiple sound card
mappings simultaneously.

Step 1 Navigate to Settings > System > Audio to access the audio settings interface.

Figure 6-5 Audio settings
System

At P oo
Fame Audio Mapping

Display + New Mapping

Office
Sound Ca ppingl ¢
Communication _ s
Card o Channels

und 1 times @ Channels Default ~ ©

Step 2 Click New Mapping to create a new sound card mapping.
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Figure 6-6 Add sound c ard mappings

Audio Mapping

+ New Mapping

=|s Default ~

O

Step 3 Click == nextto Sound Card Mapping 1 to rename the sound card mapping.

Step 4 Click the dropdown menu below the sound card mapping to select the corresponding sound

card.

Step 5 Select the number of channels for the current sound card in  Channels.

Click @ on the right to add a sound card to the current mapping and configure its
channel count.

Click @ next to an added sound card to delete it.

Once sound card mapping is configured, select a layer and choose the newly added sound

card mapping in the Sound Card Mapping option in the layer properties.

Click .@. next to Sound Card Mapping to delete the added sound card mappings.

6.2 Shortcut Binding

The software supports adding custom shortcuts, allowing users to operate it quickly through
personalized shortcuts. By navigating to Settings > Shortcut Binding , you can access the
shortcut binding settings interface, and the function areas where shortcuts  can be added will be
highlighted.
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Figure 6-7 Shortcut binding interface

Click the target function area, then press the desired letter or number key combination on

the keyboard to add the shortcut key.

After adding the shortcut, navigate to  Settings > Complete Binding or use the built -in

shortcut Ctrl +Shift +K to activate the set shortcut and exit the shortcut binding interface.

E Note

When setting function shortcuts, the system built -in global shortcuts cannot be used.

For example, set the shortcut for Prog ram 1 to "w".
1. In the shortcut binding interface, click P 1 to select the program 1.

2. Pressing W on the keyboard will display the shortcut on the program 1.

Table 6-1 Built-in shortcuts

Keys Description

Ctrl+H The mouse quickly returns to the center of the software interface.
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Keys Description

Ctrl + Left/Right arrow keys In the case of multiple monitors, adjust which monitor displays the

main interface.

Arrow keys, PgUp, PgDn When playing the PowerPoint slides, flip through the slides up and

down.

6.3 Configure MIDI and D MX Shortcuts

Prerequisites

For MIDI control, complete the MIDI configuration in section ~Communication .

For DMX control, complete the DMX configuration in section Communication .

Procedure

Step 1

Step 2

Step 3

Step 4

Navigate to Settings > MIDI Binding or Settings > DMX Binding to enter the MIDI or DMX

binding settings interface. The areas where shortcut binding can be applied will be highlight  ed.
Click the highlighted area to select the function to be bound.

Press the corresponding button on the MIDI or DMX device panel to complete the shortcut

binding configuration.

Repeat the above steps to bind additional functions.

6.4 Configure OSC Bindings

Step 1

Step 2
Step 3
Step 4

Step 5

Ensure the PC has TouchOSC Editor and TouchOSC Bridge installed, and the mobile device has
TouchOSC installed.

Run TouchOSC Editor and TouchOSC Bridge on the PC.

Open TouchOSC on the mobile device.

In TouchOSC Editor on the PC, design a shortcut keyboard a nd save it.

In Kompass FX3 Pro, navigate to Settings > OSC Binding to enable OSC binding.

Highlighted areas for shortcut binding will appear.
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Step 6 Click a highlighted area to select the function to be bound. The OSC Parameter will appear in

the bottom right cor ner, and copy the parameter.

Figure 6-8 Select binding functions

Step 7 In TouchOSC Editor on the PC, select the designed shortcut and paste the copied OSC
parameter into the corresponding button's URL in the TouchOSC software.

Figure 6-9 OSC parameter settin gs

B TouchOSC Editor - Untitled 1 — [m] X
¥ L = p Zoom 100% w &)
O & & &8 X B 8 ¢ ~ § | @
Tew Open Save  Save As Cut Copy Pastz:  Delete Tnda Redo Gid[]| 3 Syme About

Name: pushl

i ISLIE B § 45[2
¥ 2y = 45 [
0sc WIDT Eey
03¢ [] auta

| seripherals/Global/OutputSwitcl| |

Value Range

From 0 Te: 1k

Send on ' Press’
Send on 'Release’
[JLacal feedback off
[ ¥ positien velocity

Invert

Step 8 Repeat steps 6 and 7 to bind additional functions.

Step 9 Sync the designed keyboard from TouchOSC Editor to the mobile device.
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Step 10 Open the designed keyboard and input the shortcut to send control commands to Kompass

FX3 Pro.

6.5 Clear Shortcut Bindings

The clear shortcut function allows you to remove all configured shortcuts.

Navigate to Settings > Clear Binding > Clear Shortcuts to delete all keyboard shortcuts at

once.
Settings > Clear Binding > Clear MIDI to delete all MIDI shortcuts at once.

Settings > Clear Binding > Clear MIDI to delete all DMX shortcuts at once.

6.6 Signal Monitoring

In the main interface, click MIDI, DMX, or OSCin the upper right corner to enter the signal
monitoring interface. Click the peripheral control name on the left to view the executi  on process

of different peripheral control commands, including the time, url and value.

Figure 6- 10 Signal monitoring

Signal Monitor

sMIDI
®DMX

0 0SC

Time: The timestamp of peripheral control
Url: The control command executed

Value: The final adjusted parameter value
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7 Tools

7.1 Playback Control Assistant

Kompass FX3 Pro supports converting the encoding, bitrate, resolution, and frame rate of

imported videos, as well as encrypting videos to meet playback scenario requirements.
Step 1 Navigate to Tools > Playback Control Assistant to access the interface.

Figure 7-1 Playback control assistant
Playback Control Assistant 1&=/Language: English

O  Import Path Encoding Format Frame Rate  Resolution Duration
o Ci/Users/Nova001395/... h264 29 38402160 00:00:10

/MNova001395/.. h264 23 38402160 00:00:24
Device ID
Quality

Resolution W

Audio  AAC(Recommended)

Apply to All

Yo

~
~
~
-

Add Delete Clear Optimize

Step 2 Click Add at the bottom, and select the video or image files to be transcoded in the dialog box.

Hold the Ctrl key and click files to select multiple files.

Drag and drop selected files into the file list area of Playback Control Assistant to quickly add

them.
Step 3 Select the file to add it for transcoding.

Step 4 Check the file to be transcoded.
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Step 5 On the right, configure the following parameters:

Coding: Set the coding format of the transcoded video. The supported optio  ns include Self-
Adaptive , h264,h265, VP9 and hap.

When Self- Adaptive is selected, the video will be transcoded according to the original video

coding.
Keep HDR: Set whether to retain HDR in the converted video.
T Selected: The converted video retains the HD R of the original video.

T Deselected: The original video's HDR is not retained, and the converted video will be in
SDR format.

Keep Alpha Channel: Set whether to train the original alpha channel for the HAP videos.
T Selected: Retain the alpha channel information for the HAP video.

T Deselected: Do not retain the alpha channel information and the system will

automatically fill in the alpha channel.
Copyright: Encrypt the selected video, making it playable only in Kompass FX3 Pro.

T Select Copyright (encrypted. nvf) : Enable video encryption and convert the video file

to the .nvf encrypted one.
T Password: Set a password for the encrypted video.

T Auth Expire: Set the authorization duration for the encrypted video. The value ranges
from 1 to 999. Once the authorization duration is exceeded, the encrypted videos will

show as Expired in the media library.
T In Device ID, enter the device identification code, which can be foundin  Help > Device
ID. Click + nextto Device D THh Ekk ZOyTS&8NylL 1 BkLP

Once the device ID is filled in, playback is restricted to the software associated with that

code, regardless of whether a password or auto expire duration is set.

Table 7-1 Copyright description

Password Auth Expire Description

Empty Empty The video is .nvf encrypted , but can be played directly
without password decryption.

Non-empty Empty The video is .nvf encrypted, and requires password
decryption in the media library to play.

Empty Non-empty The video is .nvf encrypted within the authorization
duration, but can be played directly without password
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Password Auth Expire Description
decryption.
Non-empty Non-empty The video is .nvf encrypted within the authorization

duration, and requires password decryption in the

media library to play.

Quality: Set the quality of the transcoded video. The suppor ted options include Low,
Medium and High .

T High: Keep the quality of the transcoded video the same as the original video quality.

T Low: The quality of the transcoded video is relatively blurred compared to the original

video quality.
T Medium: The quality of t he transcoded video is between the high and low qualities.

Code Rate: Set the code rate of the transcoded video. The supported options include  Self-

Adaptive and Custom .
T Adaptive: The code rates before and after the transcoding are the same.

T Custom: Set the desired code rate and the video will be transcoded according to the set

value.

Frame Rate: Set the frame rate of the transcoded video. The supported options include  Self-
Adaptive , 24, 30, 60 and Custom .

T Adaptive: The frame rates before and after the transcoding are the same.

T 24/30/60: The frame rate after the transcoding will be 24 Hz, 30 Hz, and 60 Hz,

respectively.

T Custom: Set the desired frame rate and the video will be transcoded according to the

set value.
Resolution: Set the resolution of the transcoded video.

T W: Set the horizontal size of the transcoded video. The value defaults to 1920 and can

reach a maximum value of 8192 (recommended).

] H: Set the vertical size of the transcoded video. The value defaults to 1080 and can

reach a maximum value of 8192 (recommended).

Audio: Set the method for audio transcoding during video transcoding, with options for
AAC, Copy, or No Audio .

T AAC: Re encode the original audio in AAC format after transcoding.

T Copy: Retain the original audio in the video after tra nscoding.
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T No Audio: Transcode the video to contain only images, without any audio.
Step 6 Repeat Step 4 and Step 5 to set the transcoding parameters for other video files.

Once one transcoding is configured, if the transcoding parameters of other selected videos are

identical, click Apply to All to apply the current transcoding settings to all selected media.
Step 7 Perform the video cropping or splitting.

The assistant allows the selected videos to be cropped and split.

Crop: Check the box nextto Crop to crop the selected video. Use X and Y to set the starting

position, and W and H to set the crop size.

Split: Check the box next to Split to divide the selected video into multiple segments by

setting the number of Rows and Cols.

Enable GPU Acceleration: Toggle GPU acceleration for the video transcoding process on or
off.

Step 8 Click Transcode and the system will automatically start the transcoding process.
When the progress shows o in the Progress, the transcoding completes. After the
transcoding, the video will be saved in the path specified in ~ Save Path.

Step 9 Click Open to open the local folder where you can view the transcoded files.

Click Change to change the save path.

Click Delete at the bottom to delete the selected video files.

E Note

The playback control assistant and playback logs windows do not automatically close wi  th the

main user interface and require manual shutdown.

7.2 Play Log

Kompass FX3 Pro automatically logs media playback statistics, including start time, end time,

total duration, and playback count for a selected period.

Step 1 Navigate to Tools > Play Log to open t he interface.
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Figure 7-2 Play log - 1

Play Log

Date Today ~ From 2025/03/18 00:00:00 J To 2025/0 3:59:59

Media Name Search

No Media Name Start Time End Time Duration Times

Step 2 Select a time range for log data statistics. Options include Today, 7 Days, 1 Month , and 3
Months .

E Note

To ensure complete playback logs, set the Log Storage duration in Settings > System to a

value greater than the selected time range.

Step 3 Set the start time and end time for the playback logs.

Step 4 Enter a media name in the Media Name field to query logs for a specific media file. Leave it

blank to view all logs.

Step 5 Click Search to search and displa y the playback logs.
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Figure 7-3 Play log - 2
Play Log

Date Today ~ From 2025/03/17 00:00:00 . To 2025/03/18 23:59:50 [

Media Name Search 10/10

Start Time End Time uration Times
2025 7 10:55:50.098 2025-03-17 10
2025-03-17 11:01:43.849 : 3-17 17:31:25.965 6h29m42s116ms
7 17:31:26.020 6h29m425167ms
6h29m42s16
Grape 2025-03 z 6h29m42s
abc 2025-03 31:25.38 : 3-18 09:39:25.96 16h8m0s5
01 2025-03- 8 2025-03-18 09 550ms
14 2025-03-18 369 2025-03-18
1 2025-03-18 37 2025-03-18 09

Grape 2025-03-18 37 2025-03-18 09:39:4 16s800ms

Step 6 Click Export to save the playback logs locally.

7.3 Port Check

The port check tool is used to scan and query the port information of Kompass FX3 Pro.

Navigate to Tools > Port Check to enter the port check interfac e and view the port details of
the software.

Figure 7-4 Port check

Port Check

Port List
Port Desription
RPC service TeEss < (TCP) (PID: 16804)
19978 VICP service Normal
19958 TCP port Chec

18959 UDP port Checking...

5048 Link service Checking...

TCP and UDP ports can be modified and configured in the Settings > System > Peripheral .
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8 Help

8.1 User Manual

Navigate to Help > User Manual to open the software user manual.

8.2 About Us

Check the software version, license duration, licensing agreement, and more information.

8.3 Language

Switch the software Ul language.
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9 Al Assistant

9.1 Al Assistant

Al Assistant is a versatile Al tool based on large models such as Nova and DeepSeek, providing
accurate Al chat services to quickly answer questions and offer software operation guidance.
Additionally, it allows users to generate personalized images by entering prompts, selecting
image ratios, and styles. The integrated web search feature enables users to ac cess real-time

internet information, catering to diverse needs.
Prerequisites

You have completed the software authorization.

You have logged in the software.
Limitations

Each account is limited to 100 Al chat operations and 10 image generation operationsp er

day.

Only one image is generated per operation, consuming one image generation count.

9.2 Register Account

Step 1 Click Login at the top right to open the login window.
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Figure 9-1 Login window

Login

Account

[ Phone Number

0086 Chin

O I agree to the

Login

No account ?

Step 2 Click Select Server to enter the server selection interface.
Step 3 Choose a server node, then click OK.
Step 4 Click Register Now to enter the registration interface.

Figure 9-2 VNNOX registration

Sign Up
° Identity Verification Complete Account Information Done

[ Phone

0086

I agree to the Terms of Service and Privacy Policy

Already have an account? Log in

Step 5 Choose the registration method. The options include Phone and Email.
Step 6 Enter your phone number or email.

Step 7 Check | agree to Terms of Service an d Privacy Policy .

Step 8 Click Send Code and complete the slider verification in the pop -up.

Step 9 Enter the received verification code into the text box.
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Step 10 Click Next to enter the Complete Account Information interface.

Figure 9-3 Complete account information

Sign Up

\:'\/\:\ Identity Verification o Complete Account Information Done

* User Name

* Password

* Confirm Password
* Enterprise Name

* Enterprise Address
* Business Role

Application Scenarios (Select all that apply.)

e

Step 11 Fill in the user name, password, and enterprise information, then click Submit to complete

registration.

9.3 Log In Account

Step 1 Click Login at the top right to open the login window.
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Figure 9-4 Login interface

Login

Account

[ Phone Number

O I agree to the

Login

No account ?

Step 2 Click Select Server to enter the VNNOX server selection interface.
Step 3 Choose a server node, then click OK.

Step 4 Click Verification Code or Account to select login method.

Step 5 Enter the account information.

For verification code login, after entering your email, drag the slider to the fa  r right and get a

code, and then enter the received code into the text box on the left.

For account login, after entering your user name and password, drag the slider to the far right
to complete verification.

Step 6 Check | agree to the Terms of Service and Priv  acy Policy .

Step 7 Click Login to enter the device authorization verification interface.

Step 8 Drag the slider to the far right to receive the verification code by email or phone.
Step 9 Enter the received verification code in the text box.

Step 10 Click OK to complete the login.

9.4 Al Assistant Operations

9.4.1 Al Chat

Step 1l Click ¢ to open the Al Assistant interface.
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Figure 9-5 Al assistant
Al Assistant

Hello, I' m your Al Assistant.
Nice to meet you!

&iGenerate Image

& Deepseek @ Web Search 0/200

Step 2 Click Al Chat to select the Al Q&A function.
Step 3 Enter your question in the text box below.

To ensure accurate answers, it is recommended to ask specific, clear, and unambiguous

questions with sufficient context. A maximum of 200 characters is supported.
Step 4 Set the Al thinking mode, supporting DeepSeek and Web Search modes.

DeepSeek:

i ¢Z al® TilL OPLO P OOULPTS§BZ §P ZBT OBVZk &8Z TrilL

system will use the DeepSeek model to provide suggestions.

i ¢00 a0 TFL OPLO P ©0LPTS8§HZ &8P ZbT OBOZK 87 Til

system will use the default Nova model to provide suggestions.
Web Search:

i On:Web searchis enabled, andthesysTL Z NByy PLEOIF TFL 8§ZTLOZLT

guestion to provide suggestions.

1 Off: The system will not perform a web search and will rely on the current product

knowledge base and the selected large model for reasoning.

Step 5 Click Send to let the system process the question and provide an answer.
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9.4.2 Image Generation

Step 1

Step 2

Step 3
Step 4

Step 5

In the Al Assistant interface, click Generate Image to enable the text -to-image function.

Figure 9-6 Image generation

Enter the basic requirements for the image in the textb ox below.

When using Al to generate images, please provide clear and detailed text descriptions,
including the theme, detalils, style, emotion, and any specific requirements, to help the Al
accurately understand and create images that meet expectations. Am aximum of 200 characters

is supported.
Select the desired image aspect ratio from the default 16:9 options.
Select the desired image style from the default Portrait Photography  options.

Click Send to let the system generate an image based on the input text . Only one image is

generated per operation.
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